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Welcome 

A helpdesk system integrated seamlessly within your Microsoft Office Outlook, transforming it from a simple email client 

to a fully-fledged service provider.  

This is an elaborate help documentation that will guide technicians on how to install, configure, and work with 

support cases in Outlook. Graphic illustration and screenshots of the screen/forms are used with proper marking 

wherever they are required to drive down the point of the relevant topic.  
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1. Introduction  
Team Helpdesk is an ITIL guided, issue tracking and ticketing system with integrated asset management that is available as an 

add-on for Microsoft Outlook. It is the only comprehensive helpdesk system entirely integrated seamlessly within your 

Microsoft Outlook, transforming it from a simple email client to a fully-fledged service provider. Using Microsoft Exchange and 

SharePoint as repository for storing support cases, it provides support staffs with all the necessary tools to log, collaborate, 

analyze and assist in the resolution of help desk issues. Various medium of communication supports automated messaging 

and notification requiring no human inputs.  

Apart from e-mail, the ability to send SMS and make phone calls directly from your Outlook extends the exchange of 

information to a new level, thereby, making it possible to integrate customer relationship management (CRM) processes in 

core help desk functionalities. 

With inbuilt support for advanced statistics and varied reporting options, support managers can evaluate the performance of 

the helpdesk and in-turn ensures timely decision making for improved service. Most of the Team Helpdesk functionalities in 

Outlook are also available via a web browser through web access - perfect for remote support staffs. Furthermore, caller can 

submit new support requests via a web form, login to caller web access to track and escalate support cases, check status, or 

search through the knowledge base, all via a web browser for first level support.  

To sum up, Team Helpdesk improves the efficiency of the help desk to enable faster response time and higher productivity for 

your organization at lower operating costs. After all, the bottom line for your help desk team is for your end-users to receive 

better and timely service. 

Benefits for your organization: 

 Work on cases in your Outlook as if you would work on emails 

 Single enterprise-wide view of support cases, callers, problems and resolutions 

 Little or no training requirement on the part of your support technicians 

 Centralized data storage on Microsoft Exchanger (mailbox or public folder) - efficient platform for collaboration 

 Enable integration with Active Directory  

 Common point-of-call for your callers 

 Structured workflow for all helpdesk activity  

 Freeing up valuable human resources by automating cases logging, sending notifications etc. 

 Higher productivity and increased "up-time" for support staffs  

 Organized state of cases means faster tracking requests 

 Identify problem areas and increase helpdesk efficiency  

 "Do more with less" - affordable one-time fee with enterprise-wide license  

 

Benefits for your customers:  

 Always in communication loop via the power and ease of automated email/messaging 

 Inspires confidence to the help desk service 

 A knowledge base that a caller can search through for resolution to their query 

 Check on the progress or status of the case via web 

 Request support in a standardized way through email, phone calls or web form submission  

 Case get resolved in a timely manner and hence customer satisfaction 

 Helps in building trust and loyalty in your brand 
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2. How It Works?  
Team Helpdesk System consists of two separate installs – Managerial and Agent. 

 

• The Managerial install is for helpdesk administrator who would configure and maintain the Team Helpdesk folders, drop 

down lists, templates, FAQs and other helpdesk settings. 

 

• The Agent install is for the technicians to enable them to work on support cases in Outlook with the configured Team 

Helpdesk folders. 

 

Each of this tool is installed on individual computer as an extension to Microsoft Outlook and only relies on Microsoft Outlook for 

the front-end and your exchange server and a network database, as the back-ends.  
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Step 1. Manager creates a settings 

database 

After the managerial tool is installed, 

helpdesk administrator will be given a choice 

of database options where all the settings, 

templates and other helpdesk data will be 

stored centrally.  

Database options include Microsoft 

Exchange, Microsoft Access, Microsoft 

SharePoint, SQL Server, Microsoft Azure 

(cloud SQL server).  

 

 

Step 2. Manager configures 

helpdesk settings and drop downs 

Helpdesk administrator defines drop-down 

lists such as technicians, callers, problems, 

assets, as well as emails and SMS templates, 

predefined replies, messaging options, web 

access etc. With these global settings, 

manager can streamline the behavior on how 

all technicians work on support cases in 

Outlook. 

Administrator can also set the manager add-

in to monitor any number of mailboxes and 

email folders, for automatic processing of 

incoming emails to support cases. This 

process cuts the overhead of manually 

generating support cases from emails, thus 

diverting valuable human resources to 

resolving the case. 
 

Step 3: Manager maps helpdesk 

fields from Outlook to SharePoint 

The next step is for the helpdesk manager to 

configure a SharePoint list to be used as for 

storing copies of support cases that were 

generated in the 'Ongoing Cases' subfolder of 

Team Helpdesk in Outlook.  

New fields in the SharePoint list can be 

automatically created to match the data type 

and title of the Outlook helpdesk fields. 

If the particular mapped field takes a drop-

down list in Outlook such as Problem 

Category, Problem Type, Status, Callers 

Name etc., the same drop-down list values 

would be available in the configured list 

automatically. Over time, as manager make 

changes to the drop-down lists in Outlook, 
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Team Helpdesk would automatically update 

the values in SharePoint too. 

 

Step 4: Technician installs Agent 

add-in 

The Agent tool consists of an Outlook add-in 

that has all the logic and functionalities of 

the helpdesk application. Each technician of 

the helpdesk who would work on support 

cases needs to install the Team Helpdesk 

Agent tool. 

After a successful install, you will see that 

additional menus, toolbars or ribbons are 

added in the explorer and inspector windows 

of Microsoft Outlook. 

Note: Apart from the managerial tool, helpdesk 

administrators also need to install the client tool if they have 

to work on support cases themselves. 

 

Step 5. Caller submits support 

request via email, web form or 

phone call 

An end-user experiencing technical 

challenges can self-service the answer to 

their problem by accessing the web-based 

knowledge base (through the Team Helpdesk 

Customer Web Service site). 

If a solution is not found, the end-user 

requests for support by sending an email, by 

making a phone call or simply, by filling a 

web form. These support requests are then 

logged and converted to cases in Outlook. 

Further details and drop-down lists (such as 

the classification of problems the request 

falls into) can then be set, by a supervisor or 

manager. 
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Step 6. Assign technicians to the 

case 

Typically, a manager or senior technician 

assigns the best technicians to the case for 

fulfillment of the service and speedy 

resolution.  

Furthermore, in the helpdesk settings, 

administrator can link and associate 

individual technician to a caller, or to a 

problem type such that when a new support 

request email is received, if there is a match 

between technician and the caller (read as 

sender), or if a problem type is found in the 

email subject, the associated technician will 

get assigned automatically to the case. 

 

Assigned technicians then get notified through an automated email or SMS. 

Optionally, the due date of the case is entered into the personal calendar of the 

technicians' mailbox. 

Step 7. Technicians collaborate to resolve the case 

The assigned technician then proceeds to fulfill and resolve the case, either in Outlook or via Technician Web Access (TWA). 

Helpdesk manager may enforce a Service Level Agreement (SLA), set due date and other deliverables on the particular case for 

the assigned technicians, for quality check purposes. Further correspondence to the caller might follow (in the form of emails, 

SMS, phone calls). All activities related to the case are logged and technician can fill time spent and assign additional technician if 

needed. Relevant asset information and fixes related to the case can be accessed and tracked right from the case form itself. 

Step 8. Caller follows-up via email 

The caller can reply back to email from the helpdesk and the response automatically triggers an escalation on that particular 

support case. If a response from the caller on an existing case is received, the concerned technicians are notified automatically. If 

the case has been resolved, Team Helpdesk automatically re-opens and marks it as an ongoing case. 
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Alternatively, caller can also choose to escalate, withdraw, reopen or simply track the history of their support cases online by 

logging into the Caller Web Access (CWA) website (that comes with Team Helpdesk). 

 

Step 9. Technician closes case after 

providing a resolution 

Certain pre-defined Outlook views can be 

used to track the progress of cases. Once 

every parameter of the caller's request has 

been fulfilled, a case be closed. The closed 

case is then moved to the Resolved Cases 

folder. At the same time, the caller gets 

notified automatically on the closure of the 

case. 
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Step 10. Technician adds resolution to knowledge base 

A closed case can be a good source of future reference and technician can create a new knowledge base entry based on the case. 

It is then available in the list of articles under the integrated knowledge base, categorized and sorted, ready for your technicians 

to draw from when similar issues arise. Helpdesk administrator can publish these articles on to the Customer Web Service site for 

providing first level support to potential support requests from end-users. 

 

 

Step 11. Manager generates statistical and trend reports 

To identify problem areas and increase helpdesk 

efficiency, senior management runs the 

statistical tool from time to time, collecting 

valuable intelligence and trends and generating 

meaningful reports.  

 

For day to day knowledge of the helpdesk, they 

can generate summary reports to get appraisal 

on the current happenings on the helpdesk and 

track recent cases generated, worked, closed or 

reopened. 
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Step 12. Manager archives old cases to database or PST 

Over time, the Team Helpdesk folders (in Exchange) will be accumulated with support cases mostly resolved ones. Helpdesk 

managers can either archive the old case items to a PST file or can export the case data to an external database such as Oracle, 

SQL or Access. Archiving periodically keeps the exchange folder from getting too big and unwieldy, which could cause 

Exchange/Microsoft Outlook performance to slow down. 
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3. Requirements  
Team Helpdesk is available right inside your Outlook unlike any other standalone application and web based help desk software. It 

can be easily deployed through an installer (manually or via a group policy object with MSI) across the entire organization.  

 

Please make sure that your system meets the following requirements before installing Team Helpdesk for Outlook: 

Windows Version  Windows Vista, 7, 8, 8.1, 10. Both 32-bit and 64-bit OS are supported.  
  

Outlook Version  Outlook 2019, 2016, 2013, 2010, Outlook 2007. Team Helpdesk operates directly inside 
the Microsoft Outlook application (using Microsoft's "COM add-in" technology). Outlook 
Express is not supported.   
  

Database  

  

Microsoft Access, all versions and editions (including Express edition) of SQL Server are 

supported including cloud services such as Amazon RDS and Microsoft Azure SQL.  

 

.NET Framework  Microsoft .NET Framework 4.5 or Higher. 

 

SharePoint SharePoint 2010 or Higher. Cloud based SharePoint such as Office 365 are also supported. 

  

.   
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4. Installation Information 
This install is meant for agents and technicians who would be working on support cases in the configured Outlook folders. Before 

you install the agent tool, make sure the Team Helpdesk Outlook folders had been already configured by the manager and that you 

know the location of these Outlook folders (ask your helpdesk manager for the location if required e.g. \\All Public Folders\Public 

folders\Team Helpdesk). This is required because you will be asked to specify the configured Team Helpdesk root folder once you 

start Outlook (for the purpose of linking up the agent tool with the Team Helpdesk outlook folders and is required one time only). 

Download link: SETUPS 

There are two different setup types: 

For 'Per User Installation' (ideal for standalone single user/workstation) 

TeamHelpdeskSPSetups_x86.zip (for 32-bit Outlook 2007, 2010, 2013, 2016, 2019) 

TeamHelpdeskSPSetups_x64.zip (for 64-bit Outlook 2010, 2013, 2016, 2019) 

For 'Per Machine Installation' (ideal for installing on Citrix and Terminal Servers) 

TeamHelpdeskSPSetups_x86_Citrix.zip (for 32-bit Outlook 2007, 2010, 2013, 2016, 2019) 

TeamHelpdeskSPSetups_x64_Citrix.zip (for 64-bit Outlook 2010, 2013, 2016, 2019) 

The downloaded zip file contains 3 files: TeamHelpdeskSPManagerSetup_xXX.exe, TeamHelpdeskSPAgentSetup_xXX.exe and 

VersionInfo.txt where ‘xXX’ can be either x86 (32-bit Outlook) or x64 (64-bit Outlook) 

Extract these file contents to a file folder. It is recommended that you place the setup files on a shared network folder, such that all 

users can have access to it, and ease the installation and upgrade process. 

Per User Installation and Per Machine Installation 

In Per User Installation, both the Manager and Agent installs are performed 100% on the local system and nothing is installed on 

your Exchange or Windows Server. Further, this install is intended to serve only the current logged on user of the 

system/workstation and will be installed under the user's application data folder (instead of Programs Files folder) and no elevated 

permission is required (This is known as per user installation). So, there won't be a prompt from UAC to allow this install unless you 

change the install directory to say, Programs Files which will warrant an elevated permission/UAC prompt. If the same system is 

used by multiple technicians, each user needs to install Team Helpdesk add-in on their profile with the default installation folder 

location. 

Per Machine Installation: If you have the need to have a single install that serves all users of the system (i.e., per machine 

installation, which technically means the files will be installed under Program files folder and the add-in will be registered under 

HKEY_LOCAL_MACHINE registry hive rather than HKEY_CURRENT_USER), download the Citrix/Terminal Server version of the 

setups to perform a per machine installation. 

 

The Agent setup is of two different types - one each for 32-bit Outlook and 64-bit Outlook 

For Per User Installation: 

TeamHelpdeskSPAgentSetup_x86.exe (for 32-bit Outlook 2007 SP3, 2010, 2013, 2016, 2019) 

TeamHelpdeskSPAgentSetup_x64.exe (for 64-bit Outlook 2010, 2013, 2016, 2019) 

 

For Per Machine Installation: 

TeamHelpdeskSPAgentSetup_x86_Citrix.exe (for 32-bit Outlook 2007 SP3, 2010, 2013, 2016, 2019) 

TeamHelpdeskSPAgentSetup_x64_Citrix.exe (for 64-bit Outlook 2010, 2013, 2016, 2019) 

 

Note: if the administrator/manager needs to work on support cases, the agent tool also needs to be installed, apart from the 

managerial portion. It is perfectly normal to have both Manager and Agent add-ins installed on the same machine. However, for 

normal technicians, just the agent add-in is enough to work with the support cases in Outlook.  

https://www.assistmyteam.com/helpdesk-addins/download-setup/team-helpdesk-for-outlook-and-sharepoint/
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4.1 Installation Steps  
The Agent installation mainly consists of an Outlook add-in that has all the logic and functionalities of the helpdesk 

application. It needs to be installed by all agents/technicians who will be working with the Team Helpdesk in Outlook. Before 

you continue the installation, it is recommended that Microsoft Outlook is shutdown (if active). 

 Step 1. Run the TeamHelpdeskSPAgentSetup_xXX.exe to start the installation. Click 'Next' to Continue. If Outlook 2010 or 

later is not installed, the setup wizard will not be able to proceed. Please also ensure Outlook is shutdown (if already running 

or active in the task manager) as the setup has to install an Outlook add-in. 

 
 

Step 2. Select the appropriate destination folder where the application files will be installed. If you change the default folder 

path, please make sure you have appropriate permission. (Note: by default, it will be installed under your application data 

folder) 
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Step 3. Click 'Next' to continue with the files extraction. It just takes a few minutes to complete the whole copying process 

  
  

Step 4. Click 'Finish’. This ends the files installation process in your system. Now start Microsoft Outlook 

  

 Now start Microsoft Outlook. If the agent add-in installation was successful, you will see a new menu item 'Team Helpdesk Agent’ in 

Outlook (after help menu). 
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Step 5. The final step of the Agent add-in installation is linking up the Team Helpdesk Agent add-in with an existing Team Helpdesk 

folder in Outlook. When you start Outlook, you will be given the option to specify the location of an existing, already configured 

Team Helpdesk folder, which may be under your public folder or shared mailbox folder depending on where your administrator had 

installed it previously. 

 

Either you can auto scan to search for the first available Team Helpdesk folder. If you already know the location of the existing 

Team Helpdesk folders, you can simply click the ‘Browse’  button to choose it from your Outlook and then click ‘Continue’.  

 
 

NOTE: You can either choose the root ‘Team Helpdesk SP’ folder or any of the subfolder within the root folder. There is no fast and 

hard rule. 

If you have chosen the correct Team Helpdesk folder, the Agent add-in should be able to make connection to the Team Helpdesk 

database, and you should be able to see Team Helpdesk specific toolbars and ribbons in the Explorer and Inspector windows of your 

Outlook. 

Additional step for Technicians/Agents on the SQL database. 

If your administrator had configured Team Helpdesk to store the settings and other configurations in a SQL server database, then 

please make sure that you have adequate permission to access and update the tables in that database i.e., db_datareader and 

db_datawriter permission on the Team Helpdesk SQL database. 
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Additional steps for Technicians/Agents on the SharePoint Site. 

i) Your permission to the SharePoint site - Make sure that you have at least ‘Contribute’ (or ‘Full Control’) permission over the 

SharePoint site. 

ii) Login Credential - When you try to raise a new case or make changes to existing ones, the agent add-in may prompt you to enter 

your credential to connect to the SharePoint site.  

 

If the SharePoint site uses the NTLM or windows authentication, the add-in will use the default credential to connect to the 

SharePoint. However, for form based or claimed based authentication (for example, Office 365 SharePoint online), it may prompt 

you (and another individual technician) to enter their credential. 

Check ‘Remember’ so that Team Helpdesk add-in can use the same credential to logon to the SharePoint site in subsequent 

connection. 

You can also specify the authentication mode that is used by your SharePoint to allow connection to it. For instance, if your 

SharePoint is configured for Windows authentication, choose ‘NTLM’. If it used a form based authentication, then choose ‘Forms’ 

whereas if it used a claimed based authentication (for Office 365 SharePoint Online), choose ‘Office 365’. If you are unsure, consult 

your administrator. 

The screenshot below lists all the files that are installed on the system. Add-in files under current user’s application data folder: 

E.g. C:\Users\[USER]\AppData\Roaming\AssistMyTeam\Team Helpdesk Agent SP (x64 or x86) if it is 'Per User Installation'. 

For 'Per Machine Installation', it would be C:\Program files (x86)\AssistMyTeam\Team Helpdesk Agent SP (x86 or x64) 
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5. Working with Team Helpdesk folders   
Once you have installed Team Helpdesk, you will find that there are a couple of 

subfolders in the main parent folder. Each folder serves a specific purpose and the 

very name reflects the kind of items it holds. 

You can of course change the subfolder name to anything that you want it to be and 

it would not break the working of the Team Helpdesk System. 

 

5.1 Ongoing Cases Folder 
 

This is the most prominent folder where technicians will be working the most! As the name implies, this folder stores all the 

ongoing cases and, most probably would be most visited and used Team Helpdesk folder. Any new case, either created 

manually or generated from out of an email would be stationed here, waiting to be attended to by the assigned technicians. A 

dedicated Outlook ribbon toolbar is used to house various drop downs options and buttons related to these folder items. And 

items in this folder are stored with the message class 'IPM.Post.THS.CASE'. This folder also comes with Team Helpdesk 

specific Outlook views numbering to around 30 or more. 

 

 

Settings menu – contains per-agent advanced tools and options for 

customization. 

 

 
 

 
Create a new empty support request case. 
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Mark the selected cases as resolved (closed). Cases marked resolved are then moved to the 'Resolved Cases' folder. 

 
Delete the selected cases from the folder. If the deleted case has any email replies, they will be also deleted. 

 
Sometimes, a caller might contact you through separate emails or channels regarding a particular issue. The same issue 

might be logged as a case by a different agent not knowing an existing one already exists. To avoid duplication and 

conflicts, you can merge all related cases together and keep the communication streamlined. 

The merge action is irreversible, and causes the following things to happen: 

a) One of the cases becomes the primary case (you get to choose).  

b) All conversations from the secondary tickets are moved into the primary case.  

c) All messages are sorted chronologically.  

 
Print the selected cases using the customizable 'Print HTML’ template. 

 
Create knowledge base items out of the selected cases. 

 
Search the 'Ongoing Cases' folder for items (support cases) with keywords. The searched result is effectively applied to 

the Outlook folder view (by means of Outlook filtering) which would result in only displaying those support cases that 

meet the searched criteria. Click the 'Clear' button to clear the search in the folder view (and revert back to the selected 

view effectively). 

 
Show/toggle the advanced search options - Apart from the free text search by keywords, Team Helpdesk also 

implements an advanced search and reporting options with an array of filters available to extract only the required 

support cases quickly within the folder view itself. 

 
The 'Ongoing Cases' specific Outlook views are the primary interface with which most technicians will scan through for 

relevant cases in this folder. The drop-down menu lists all the available views for this particular folder. Each view is 

organized to group and filter support cases to make a particular feature of your information obvious at first glance. 

 
The folder view listing all support cases grouped and sorted as per the current selected view (e.g. Technicians - Table). 

Each group also shows the number of items it holds as well as number of items that are unread. Selecting anyone of the 

case item displays the problem description in the Outlook preview pane. 

 
The Outlook preview pane displaying the problem description of the selected case item. It also displays a Team Helpdesk 

specific form region on the right side of the preview pane. This ‘Case Preview’ form shows all the available helpdesk 

meta fields including custom fields and the values these hold when you select or highlight any Outlook case item in the 

Ongoing Cases or Resolved Cases folders.  
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Through the case preview form, see all the related emails of that case directly or reply or forward or send a KB quickly 

without opening the case item in its Outlook inspector window. You can also see the private notes that are added by 

other technicians. 

 
If you and other technicians have added new cases manually in SharePoint through the web browser, such cases are not 

synced back to the Team Helpdesk Ongoing/Resolved Cases folders in Outlook i.e., copies of such cases are not available 

in Outlook. Use this button to retrieve support cases that were created directly in the SharePoint list (via web browser) to 

the Ongoing Cases folder in Outlook. 

 

NOTE: This feature can also be automated via the Team Helpdesk Manager add-in i.e., Outlook with Team Helpdesk 

manager add-in will automatically check for new cases availability in the SharePoint list and generate copies in Outlook 

on the fly. To enable it, go to Team Helpdesk Manager > Automation Options > Other Information tab, and check the 

option 'Automatically bring newly added cases in SharePoint to Team Helpdesk folders in Outlook'. 

 

Further, you can set the interval the add-in would check for the new cases in SharePoint. Additionally, you can also allow 

the add-in to send out the case allotment notification to caller, case assignment notification to technicians. 

 
Sync Cases to SharePoint – Click this to explicitly update the chosen cases to SharePoint. If the chosen case has an 

existing copy in SharePoint, the add-in will sync any changes made to the SharePoint copy of the case. If the chosen case 

has no equivalent case in SharePoint, a new copy will be created in SharePoint. 
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5.2 Resolved Cases folder 
 

This is pretty much similar to the 'Ongoing Cases' folder in term of structure, custom form and contents. The difference is the 

message class and that cases in this folder are marked complete and are not available for direct edit, i.e., the case form will only be 

available in read-only mode. To work on a resolved case, it would first have to be re-opened (which will then move the case to the 

'Ongoing Cases' folder). The message class used for cases of this folder is 'IPM.Post.THS.CASE'. Most of the Team Helpdesk Outlook 

views in this folder are similar to the 'Ongoing Cases' folder except for some specific views that are particular for resolved cases. 

 

 
 

 

Re-open the selected resolved cases by marking the items as 'Ongoing'. Re-Open cases are then moved to the 'Ongoing 

Cases' folder. 

 
Create knowledge base items out of the selected cases. 

 
With the Archive cases tool, helpdesk managers can archive old support cases periodically to a local PST file that are 

older than a certain (user-selected) date. This is an important maintenance step that would improve the efficiency of the 

Team Helpdesk System (as well as for Exchange storage). 

 

 
Sometimes, a caller might contact you through separate emails or channels regarding a particular issue. The same issue 

might be logged as a case by a different agent not knowing an existing one already exists. To avoid duplication and 

conflicts, you can merge all related cases together and keep the communication streamlined. 

The merge action is irreversible, and causes the following things to happen: 

a) One of the cases becomes the primary case (you get to choose).  

b) All conversations from the secondary tickets are moved into the primary case.  

All messages are sorted chronologically. 

 
Print the selected cases using the customizable 'Print HTML' template. 

 
Delete the selected cases from the folder. If the deleted case has any email replies, they will be also deleted. 

 
The 'Resolved Cases' specific Outlook views are the primary interface with which most technicians will scan through for 

relevant cases in this folder. The drop-down menu lists all the available views for this particular folder. Each view is 

organized to group and filter support cases to make a particular feature of your information obvious at first glance. 
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5.3 KB folder 
 

This subfolder houses a complete knowledge base system inside your Outlook and is closely integrated with the Team Helpdesk help 

desk. The KB articles are available for inserting into email replies, on cases and even appointments and tasks. An Outlook toolbar 

option is also shown and has buttons to create a new empty knowledge base, forward it to an email address or publish the whole 

knowledge base on the world wide web (AJAX website). Any default posting to this folder would take the custom form with message 

class 'IPM.Post.THO.KB’. 

 

  

 

Create a new empty knowledge base item 

 
Forward the selected knowledge base item to a contact 

 
Export the KB to file such as PDF or Word document. 

 
This drop-down menu lists all the available views for this particular folder. Each view is organized to group and filter KB 

articles to make a particular feature of your information obvious at first glance. 

 

 
A Question and Answer format is used to intuitively display Knowledge Base Articles. Each Article may have any number 

of file attachments associated, rich-text elements, and hyperlinks to other web pages. All articles are tagged with a 

related problem category and problem type. This enables the articles to be grouped by category and type in the KB folder 

view making it easier to find a particular article at time of needs. 

 

 
The Outlook preview pane (if enabled) displays a preview of the description field of the selected knowledge base item. 
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5.4 History Ongoing and History Resolved folders 
 

These subfolders store all of the originating emails and subsequent replies from the caller. That is, emails associated with an ongoing 

case are stored in the History Ongoing folder. Likewise, emails associated with a resolved case are stored under the ‘History 

Resolved’ folder.  

When you open a support case, there is a tab ‘Emails’ and it lists all the replies in chronological order that were received from that 

caller. Every help desk staff would require having editor permission over these folders to work with support cases. 

Each of this history folder includes a custom Team Helpdesk view (as shown below) that group email replies from caller based on 

case number. 
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5.5 Schedules folder  
 

This is an optional folder that Team Helpdesk will use if your helpdesk manager decides to maintain technician's due date schedule 

for cases. The idea is to enable the assigner (manager) to check for technician availability for a particular time slot before a due date 

can be assigned to finish the case.  

 

A calendar (having the same name as that of the technician) within this folder will be 

maintained for each technician and whenever a new due date is assigned or an existing one is 

changed, it would be reflected in the calendar as well. If a case is closed (marked complete), 

the corresponding due date from that calendar is removed. Each technician needs to have 

editor permission over the calendar. However, the manager or case assigners need to have 

publishing editor to be able to create a calendar subfolder if it does not exist. 

 

When due dates are assigned or changed in support cases, appointments are added or updated 

in these calendars. The purpose of these calendars is to allow helpdesk managers or other 

technicians to lookup these calendars for a suitable schedule such that the assignment of due 

date take into the consideration other assignments which may already existed for that 

particular technician. This will help prevent due date clashes and increase efficiency of the 

helpdesk staffs. 
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6. Working with the Team Helpdesk Agent UI 
The Team Helpdesk Client is the primary tool with which technicians work with support cases in Team Helpdesk System. As Team 

Helpdesk is tightly integrated into Microsoft Outlook, you will find many new interfaces specific to Team Helpdesk in the form of 

toolbars, drop-down menus, and ribbons, forms, context menus etc. plugged in to the usual Outlook explorer and inspector 

windows. These make it considerably easy to create support request from emails, send SMS, and make call or import contacts. 

 

6.1 The Settings menu 
 

The Team Helpdesk Client menu provides a central place for technicians to access to frequently used helpdesk operations. 

 

Contact Manager Launch the contact manager dialog to quick scan 

through Team Helpdesk internal list of callers and 

technicians and make a contact (email, SMS, or a call). 

Learn more 

  

Search cases Launch the advanced search manager dialog to query 

for both ongoing and resolved cases without needing 

to open the respective folders. Learn more 

 

Statistics Check which technicians are online at the current time 

with Team Helpdesk client system running in their 

Outlook. Also tells the version number of Team 

Helpdesk Client installed on the technician’s system. 

Learn more 

 

Summary Reports Launch the reports tool. Learn more 

 

Personal Settings Launch the Personal settings tool, to configure user 

level settings for phone calls, access to default 

calendar to helpdesk managers, language preference 

of the Team Helpdesk UI. Learn more 

 

Helpdesk Settings 

Data Source 

Launch the archive manager tool to push resolved 

cases from exchange folders (via Outlook) to a PST 

file. Learn more 

 

Reset Connection Shortcuts to Team Helpdesk folders in single-click 

 

Clear SharePoint 

Credential Cache 

Click this to clear any SharePoint credential from your 

system that is remembered by the add-in. Use this in 

situation where you or your admin had changed your 

SharePoint credential (i.e., password) but the add-in 

remembers the old credential leading to 

authentication error from the add-in. Once cleared, 

you will be prompted to enter your new credential. 
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6.2 Ribbon Toolbars 

 
Team Helpdesk displays a toolbar on the Outlook explorer window depending on the items content of the current active folder. This 

enables Team Helpdesk to target functionality specific to each Outlook item such as mails, posts, appointments, tasks and contacts. 

 

On Contact folder. 

 

Context Menu 
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6.3 Personal Settings 
 

The personal settings, as the name suggest, are each agent’s settings that are applied to Team Helpdesk System locally, i.e., the 

change in the personal settings are not affected to the workflow of other technicians. The personal settings differ from other 

administrative settings in the followings: 

• It is saved locally to the system's registry, whereas other administrative settings are saved on the exchange (Team Helpdesk 

Settings item) 

• It is not affected by access control mechanism (if enabled) 

• It is not affected by folder permission issue. 

 

 

Allow Phone Calls 

Team Helpdesk has built-in support for making phone calls either using Skype or attached phone to callers, technicians or 

contacts in your address book. Each technician can choose either one of these techniques. 

Skype can be used to make internet phone calls (VoIP) with a valid Skype account. The international call charges are 

reasonably prices and make sense if you have a good internet bandwidth for a quality voice over calls. Only Skype version 

2.5 and above are supported. More on making calls with Skype 

 
Default Time 

You can specify a default time (in minutes or hours) that would be initially set as the default value for the time spent when 

you try to add one in the case form in Outlook. 
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Automatically track incoming replies and update the associated Support case 

Enable this option for the incoming replies from callers to be automatically added and updated to the corresponding case. 

The agent add-in will then track and monitor the chosen mailbox for any incoming emails that are related to existing 

cases. And if one is found, it will be automatically added and updated to its corresponding case item. 

By default, Team Helpdesk Agent add-in only tracks and processes the emails associated with existing cases from your 

primary mailbox. So, if you receive emails from callers to other mailboxes in your Outlook, then you must specify those 

mailboxes too. Enabling this would force your Team Helpdesk Agent add-in to look for incoming emails in those mailboxes 

too. 

NOTE: If there are no Inboxes shown for selection above, the most probable reason is that, the email accounts configured 

in your Outlook may be of non-exchange account type like POP3, IMAP and others. In order to automatically track your 

incoming email in your account, the account type should be exchange type. 

 
Enable this option so that the add-in (after processing the replies automatically) can move the email replies (to existing 

case) from the original location (e.g., your Inbox) to the Team Helpdesk History folder. 

 

NOTE: Leaving a copy of the emails in your Inbox allows for quick access. And it makes it easier to reply to the issue too 

from your Inbox. And the add-in will continue to track the response you send to the caller irrespective of the reply being 

done from your Inbox or from the case form. 

 
Enable this option to force the add-in to scan for any unprocessed replies (that has a ID in the subject) in your Inbox 

during Outlook startup and automatically update the new replies to their associated cases. This is useful in situation 

where the helpdesk add-in was disabled temporarily, leading to email replies to existing cases not being processed. And 

once the add-in is enabled, it can scan the existing emails for any unprocessed emails. 

You can specify the number of days old the add-in will scan for unprocessed emails. 
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Automatically track outgoing replies and update the associated Support case 

Enable this option so that responses to the caller from the helpdesk are automatically added and updated to the 

corresponding case. The agent add-in will then track and monitor the chosen mailbox for any outgoing emails that were 

sent to the caller. And if one is found, it will be automatically added and updated to its corresponding case item. 

By default, Team Helpdesk Agent add-in only tracks and processes the responses to callers associated with existing cases 

from your primary mailbox. So, if you use other accounts to reply to cases, then you must specify those mailboxes too. 

Enabling this would force your Team Helpdesk Agent add-in to look for outgoing emails in those mailboxes too. 

NOTE: If there are no ‘Sent Items’ folders shown for selection above, the most probable reason is that, the email accounts 

configured in your Outlook are of non-exchange account type like POP3, IMAP and others. In order to automatically track 

your outgoing emails in your account, the account type should be exchange type. 

 
Enable this option so that the add-in (after processing the responses automatically) can move the email (to existing case) 

from the original location (e.g., Sent Items folder) to the Team Helpdesk History folder. 
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Placement of toolbars in Outlook- With these options, you can control the placement of the helpdesk toolbars in Outlook 

explorer and inspector windows. You can also choose to place the helpdesk toolbar to a dedicated tab. 

 
Show helpdesk context menu on top - Enable this option to show the helpdesk context menu in topmost position when 

you right-click any case or email items in Outlook. By default, the helpdesk menus are shown in bottom position. When 

this option is enabled, the helpdesk menu items appear at higher position in the context menu (right-click menu). 
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If the option is unchecked, the helpdesk menu items appear at the lowest position in the context menu. 

 

 

 
Placement of preview case form – Choose a layout that you would like the preview case to be placed in the Ongoing Cases 

and Resolved Cases folders – left, right, top or bottom of the reading pane. 

 
Enable this to hide the ‘Case Summary’ tab in case preview form.  

 
Enable this to hide the ‘Emails’ tab in the case preview form. 

 
Enable this to hide the ‘Notes’ tab in the case preview form. 

 
Enable this to hide the ‘Related Cases’ tab in the case preview form. 

 
Choose a language that will be used in all the Team Helpdesk UI in Outlook. The following languages are supported:  

English, Español, Norwegian, Danish, Dutch, Deutsch, French, Finnish, Swedish, Portuguese 

NOTE: When you switch to any language and save it, the chosen language will be applied to the next session of Outlook. 

Therefore, you are required to restart your Outlook for the new language to be affected to all forms, panels and UI of the 

add-in in Outlook. 
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6.4 My Helpdesk Settings Data Source 
 

Being a groupware solution, Team Helpdesk add-in requires that it stores the settings, templates and other helpdesk data on a 

dedicated database, which is accessible to all the technicians of your helpdesk. If your administrator had already installed and 

configured Team Helpdesk Manager add-in earlier, in most probability, subsequent installation of the Team Helpdesk Agent Add-in 

in other systems would automatically recognize and connect to the helpdesk database that was chosen by your administrator.  So, in 

most situations, individual technician won’t be required to input anything at all to the Helpdesk Settings Data Source panel on the 

Agent add-in. However, if for unknown reason, your agent add-in is unable to connect to the helpdesk database or is not pointing to 

the correct database (perhaps due to a database switch made by the administrator at later stage), you can explicitly enter the 

correct database information. 

 

 

 

 

Supported database options: 

 

i) Microsoft Exchange/Outlook 

Choose this option if your administrator had configured and chosen to store the settings data under the Team Helpdesk 

Settings public folder in Exchange.  

ii) Microsoft Access  

Choose this option if your administrator had configured to store the settings data to an Microsoft Access database file 

(i.e., TeamHelpdeskSettings.mdb) which is located on a shared network folder. 

iii) Microsoft SQL Server  

Choose this option if your administrator had configured to store the settings data to a dedicated SQL Server database 

located on a network server. 

iv) Microsoft Azure SQL 

Choose this option if your administrator had configured to store the settings data to an Azure SQL Database, which is a 

cloud-based relational database service from Microsoft, based on SQL Server database. 

v) Microsoft SharePoint 

Choose this option if your administrator had configured to store the settings data to a SharePoint list.  
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Importing Database Configuration from file - Database configuration file (*.dbconfig) can be imported on new machine 

or new agent from 'Helpdesk Settings Data Source' panel. And the manager/agent addin on that system will read the 

location and connect to the configured database automatically  

 
 

 
Saving database configuration to file: Database configuration can be saved to a file (having *.dbconfig file extension) 

from Helpdesk Settings Data Source panel and manager can share/deploy this .dbconfig file to other agents/users (say, 

via email or file server) so that individual technician can import that .dbconfig file to connect their manager/agent addin 

to the correct Team Helpdesk folder/database in their respective Outlook. 
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7. Working with Support Case form in Outlook 
The support request form in Outlook is especially designed to log in new case and view existing ones in the Outlook folder. 

Information catering to the case, caller, technician, problems etc. are laid out in a very intuitive way. 

 

 
 

There are various sections in the form such as time spent, email history, notes, assets, custom fields and related cases that 

technicians can easily navigate and work upon. Contact fields are accompanied by relevant buttons for making quick 

correspondence to the contact such as email, phone calls or simply sending SMS. Fields such as problem category, type, status 

and department are available in drop down format (configurable by the helpdesk manager) so as to limit the choice the 

technician can select for such fields.  

 

Managers can assign multiple technicians to a particular case if the scope of the problem extends beyond the capability of a 

technician. When setting due date of the case, the assigner can choose to lookup for an appropriate schedule in the 

technician's calendar (can be personal or a public calendar). Automatic notification messages (either via email or SMS) are 

sent out immediately to the concerned technicians once the case is assigned or a due date is specified or changed. Optionally, 

a due date appointment or task can also be added to the personal mailbox of the technicians. 

 

From directly in the case form, a technician can quickly browse, preview and select a knowledge base article or predefined 

reply and insert a relevant solution directly to the case problem description or make a quick reply to the caller. When logging 

in a new phone case, an existing caller, either from the caller list or from global address list (GAL) can be selected and it will 

automatically populate all other available caller fields such as address, phone number, company etc. 
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7.1 Case Detail 
The first section of the support request case form consists of fields related to caller, assigned technicians, problems, due date 

etc. There are also numerous buttons at the end of the fields such as email address, phone, etc., for quick communication. 

 

 

 

The unique number (referred to as case number) generated for this particular support request. Team Helpdesk uses an 

iterative count to generate new support requests. Every email communications out of Support to the callers are tagged 

with the corresponding case number such that subsequent email replies from the callers retain the same tag for Team 

Helpdesk to identify and perform various automations like adding the replies to the particular support case. Internal 

communications to technicians in the form emails, SMS, due-date appointments, tasks etc. are also tagged with the 

corresponding case number. 

 
The date/time the support request (usually an email) was first received in Inbox. 

 
The date/time the support request was logged, either from Outlook items such as email or phone call. 

The support staff (or technician) take was responsible for logging this support request. Note that, the assigned technician 

need not be the author of this case. 

 
The date/time the support request was last worked on. 

 
The date/time the first response to the caller was made (by a technician) after this case was raised. 

 
Shows the duration (in days) the support case is active. 

 
A drop-down field that consists of the problem category list. Specify the problem category to which the support request 

belongs to. 
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A drop-down field that consists of a type list (sub-category) for each problem category. The type list changes depending 

on the item selected in the problem category drop down field. 

 
Problem Category-Type: Apply default technician - This check button gets enabled when a combination of Problem 

Category and Problem Type is selected from the drop-downs. This means, checking this button would automatically 

assign the default technician (specified for that selected problem) to the current support case. If the helpdesk manager 

had restricted changes to the assigned technicians of the case, then the functionality of this button is grayed out to 

technicians with non-admin access. 

Problem Category-Type: Apply default SLA - This check button gets enabled when a combination of Problem Category 

and Problem Type is selected from the drop-downs. Checking this button would automatically enforce the default SLA 

specified for that selected problem to the current support case. Both the importance and the due date of the case would 

be then affected. 

 
This is a dependency drop down field that is tied or associated with a problem type. The name of this field is 

customizable and by default it is named as ‘Problem Field’. In this above example, it is named as ‘Zone’. You can 

customize its name; its drop down lists as well as its association with the problem list this under Team Helpdesk Manager 

> Problems List panel > Problem Field tab (last tab usually). 

 

 
This is a drop-down field that consists of the problem status list (customizable by technicians with admin access). 

 
The origin field signifies the source from which this case was raised from. 

 
This is the same Outlook importance field that takes one of these values - High, Normal and Low. 

 
Choose an ‘Allotment Template’ that will be used for this particular case. The chosen allotment template will be then 

used send notification alert to the caller when a case is raised. For instance, if someone sends an e-mail to 

UK.Support@myCompany.com, you would want to inform the customer that their e-mail will be responded to within 2 

hours between 9am and 5:30pm UK time. If they send a new case to US.Support@myCompany.com, you can inform the 

customer that their e-mail will be responded to within 3 hours between 9am and 5:30pm Eastern Standard Time. You can 

define different auto-response allotments under Team Helpdesk Manager > Templates Manager > Allotment 

Templates. 

 
Callers List – Choose a caller from the Callers List maintained under Team Helpdesk settings database for this case. 

Manager can maintain a list of callers under Team Helpdesk Manager > Callers List panel. 

 
Allows the technician to pick a user from the address book (e.g. global address list). For new (empty) support request, a 

technician can easily pick a contact from the address book (e.g. GAL) and that populates any additional caller details 

automatically. 

 
The email address of the caller. This drop-down field houses all the email address of the callers defined in the Callers list 

manager. This is useful when the technician had to manually log a new support request case, say when caller is on the 

phone. Selecting an email address automatically populates other fields such as caller name, address, phone etc.; thereby 

reducing time spent trying to log every single detail on the caller. 

Open a new email populated with details on the support request (as defined in configurable email template) addressed to 

the caller. A new compose window will be loaded on which further inputs can be made before sending it. 
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Directly send an email to the caller containing details (as defined in configurable email template) on the support request.  

The email is sent directly with no window displayed to edit or add any comments. 

 
Caller: Apply default technician - This check button gets enabled when a caller email address is selected from the drop-

downs. Checking this button would automatically assign the default technician (specified for that selected caller) to the 

current support case.  If the helpdesk manager had restricted changes to the assigned technicians of the case, this 

functionality of this button is grayed out to technicians with non-admin access. 

 
First and Last Name – First name and Last Name of the caller. 

 
The full name of the caller. For new (empty) support request, a technician can easily pick a contact from the address 

book (e.g. GAL) and that populates all other caller details automatically. 

 Allows the technician to pick a user from the address book (e.g. global address list) 

 
The telephone number of the caller. If the caller exists in the Team Helpdesk Callers list, a telephone number can be 

specified and it automatically gets listed in this field. If the caller has been picked from the address book (e.g. GAL, AD), 

this field would also get populated (provided the primary telephone of the picked user is specified in GAL or AD). 

 Call the telephone number of the caller 

 
The mobile number of the caller. If the caller exists in the Team Helpdesk Callers list, a mobile number can be specified 

and it automatically get listed in this field. If the caller has been picked from the address book (e.g. GAL, AD), this field 

would also get populated (provided the mobile number of the picked user is specified in GAL or AD). 

 Call the telephone number of the caller 

 Send a SMS message to the mobile device of the caller 

 
The internal department/category to which the caller is assigned to. This field also gets populated automatically if the 

caller exists in the Team Helpdesk Callers list or in the address book (e.g. GAL, AD). 

 
The full correspondence address of the caller. This field also gets populated automatically when caller is specified from 

the Team Helpdesk Callers list or picked from the address book. 

 
The organization/company to which the caller works for. This field gets populated automatically when caller is 

specified from the Team Helpdesk Callers list or picked from the address book. 

 

 
Apply default technician – This checkbox gets enabled when the company field is populated with a value or is selected 

from the drop-downs. Checking this button would automatically assign the default technician (associated with that 

company) to the current support case.  If the helpdesk manager had restricted changes to the assigned technicians of the 

case, this functionality of this button is grayed out to technicians with non-admin access. 

 
The technicians who are assigned to this support request case. By default, only one technician can be assigned to a case. 

But that of course can be bypassed by the helpdesk manager by simple enabling an option in administrative settings.  

During new support case logging, there are two ways Team Helpdesk may populate this technician field automatically: 

1. When a new support request is submitted from a web form by an end-user, depending upon the selected 

problem area, the default technician linked to that problem area (that is, in the problems list manager) would be 

assigned to this case.  

2. When a support request case is generated from an incoming email (auto-conversion mode), if the sender already 

exists in the Team Helpdesk Callers list and if a default technician is assigned for that particular caller in that list, 

then the technician field in the support case form would be populated automatically.  

In both scenarios, the notification email/SMS or reminder options in the technician's mailbox calendar would be 

triggered automatically as a consequence. 

 Select a technician from a list 
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 Assign yourself to the case 

 Remove the selected technicians 

 Open a new email populated with details on the support request (as defined in configurable email template) 

addressed to the selected technicians. A new compose window will be loaded on which further inputs can be added 

before sending it. 

 Directly send an email to the selected technicians containing details (as defined in configurable email template) on 

the support request.  The email is sent directly with no window displayed to edit or add any comments. 

 Call the telephone number of the selected technician. 

 Send a SMS message to the mobile device of the technician. 

 Add/update the due date appointment to the mailbox calendar of the selected technicians. If successful, it 

automatically triggers a reminder popup on that technician as well as get added to Outlook today page. 

 Add/update the support request task to the mailbox task folder of the selected technicians. If successful, it 

automatically triggers a reminder popup on that technician as well as get added to Outlook today page. 

 

NOTE: Typically, a manager or senior technician assigns the best technicians to the case for fulfillment of the service and 

speedy resolution. Furthermore, in the helpdesk settings, administrator can link and associate individual technician to a 

caller, or to a problem type such that when a new support request email is received, if there is a match between 

technician and the caller (read as sender), or if a problem type is found in the email subject, the associated technician will 

get assigned automatically to the case. 

 

Assigned technicians then get notified through an automated email or SMS. Optionally, the due date of the case is 

entered into the personal calendar of the technicians' mailbox. 

 
A drop-down field listing all defined Service Level Agreements (SLA) of the organization. When a SLA is enforced to a 

support case, the importance of this Outlook item is automatically set to that defined by the SLA as well as the due date 

is adjusted to reflect the response time of that SLA under which the case should be resolved. 

 
Respond by date - duration within which the assigned technicians of the case should have responded to the caller for the 

first time (after the case was logged).  

The manager can set an initial response time by manually specifying one after the case was raised, or a default date/time 

could be set under Team Helpdesk Manager > Automation Options > New Case tab. 

Additionally, when a service level (SLA) is enforced to a case, the 'Response by Date' field is adjusted automatically with 

the response time of the applied Service level. 

 reset the respond by date to none. 

 
The due date field enables helpdesk manager to set a time before which the support request case should be resolved. 

There are lot of automatic notifications and reminders options that can be sent to concerned technicians when a new 

due date is specified or updated. For example, when a new technician is assigned, Team Helpdesk can send out 
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notification email or SMS informing technicians on the due date of the support request. Team Helpdesk can also 

automatically add/update a due date appointment or task to the personal mailbox calendar of the concerned technician. 

When deciding to set a due date for a particular support request case, helpdesk managers can look up the schedule 

calendar/personal calendar of a prospective technician in order to find availability of the said technician. (Note: for 

personal calendar, the managers need to have access rights to the technician's mailbox). 

 reset the due date to none. 

 lookup the schedule calendar of the assigned technician to see workload and availability of the technician on a 

particular duration. 

 
 

 
This is the ‘Custom Fields’ section. If your helpdesk requires to collect more in-house information on the case, manager 

can add any number of additional fields from Team Helpdesk Manager Addin > Custom Fields panel. All the deployed 

custom fields would be then available in the case form for input. 
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7.2 Emails 
The Emails section shows all email correspondences received from the caller or sent to the caller on a support case. The emails are 

ordered chronologically with the newer emails at the top listing. Notice that each email item listed has a Team Helpdesk case 

number tagged to the subject for tracking and identification.  

 

NOTE: Emails shown in this section are stored in the History subfolder located within the parent Team Helpdesk folder. For instance, 

emails associated with an ongoing case are stored under the ‘History Ongoing’ subfolder, whereas those associated with a resolved 

case are stored under the ‘History Resolved’ subfolder. 

 

 

Open and view the selected email in its own (separate) inspector window of Outlook. 

 
Delete the selected emails permanently. 

 
Arrange the email preview pane side by side with the emails list pane (vertical positioning). 

 
Arrange the email preview pane to locate at the bottom of the emails list pane (horizontal positioning). 

 
Make a reply to the selected email. 

 
Make a reply from the selected email to the caller as well as to all the recipients in the CC field (if any). 

 
Forward the selected email to another user. 

 
Reply the selected email with a chosen snippet of the frequently asked question (or predefined answer). 

 
Reply the selected email with the content of a chosen knowledge base article (KB) including any attachments and images. 

 
The preview pane showing the contents of the selected email. This gives you direct accessibility to the emails without 

requiring you to open them in their separate inspector windows. To open an email in its native Outlook inspector 

window, double-click the email entry in the list pane. 
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7.3 Time Spent 
The Time Spent section lists all work sessions performed on the support case by the technicians, managers. This time spent field can 

be made optional or mandatory before marking the case as closed. By default, it is optional. Also, to calculate cost of supporting the 

case in statistics, Team Helpdesk needs to have a valid work time from the concerned technicians. 

 

 

List of all time spent entries made by technicians assigned to the case when working to resolve it. Apart from the time 

spent value (either in minutes or hours), each record in the list shows the technician name who made the entry, the date 

and time etc. 

 
Shows the total time spent (either in minutes or hours) made so far on this particular case. 

 
Enter a new time spent value to the case. A pop up dialog allows you to enter a duration (in minutes or hours), as well as 

description of the work done. Further, you can choose another technician if you are making this entry on behalf. 

 

 

You can also enter a start and end time so that the duration is automatically calculated. 
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Edit an existing time spent entry. You can also modify the time spent value and description. The technician and time 

stamp are however, read-only. 

 

 
Remove the selected time spent entries from the case.  

NOTE: you need to save the case in order for the removed entries to be permanently reflected to the case. 
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7.4 Assets 
The assets section in the support case provides fields for all of your organization's hardware and software inventory. An asset may 

be cataloged and categorized by Asset Types. All the asset fields except for the asset name can re-titled to adapt and take any of 

your organization’s intrinsic properties of inventories such as Make, I.P. Address or OS information; providing invaluable information 

directly from trouble case to the technicians resolving the support request. 

 

 
List of assets related to the problem reported by the caller. 

 
This drop down contains all the assets of the organization (as defined by the administrator using Team Helpdesk 

Manager add-in > Assets List). To add and associate this case with an asset, choose it from the drop down and click ‘Add’ 

button. 

 
Click to add the chosen asset to the case. The reported problem (as tagged in the case) can be linked to multiple assets. 

 
If you don’t remember the asset name 

(true if your organization has 

hundreds to thousands of them), you 

can make a keyword search. 
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Remove the selected assets from the list (and delink them from the case). 

 
Show the list of cases that have the same asset. To open a specific case, select it and either click ‘View’ button located 

just above the list, or double-click the case. 

 
Open the selected case in its own case form (inspector window). 

 
Choose whether to show related for ongoing cases or resolved cases or for both. 

 
Asset Information tab shows you the inner fields and data of the selected asset. The captions of these asset fields are 

customizable to meet the requirement and nature of your inventories with the Team Helpdesk Manager add-in. 

 
Save any changes made to the asset fields back to the case. 

 
This tab shows any additional fields you administrator might have added and deployed (for the purpose of collecting 

more information on the asset). This fields can be added and customized from Team Helpdesk Manager add-in > Assets 

Fields > Additional Fields. 

 

Associating problems and incidences with actual hardware and software inventory is crucial to maintaining proper preventative 

incident management and finding the core problem to repetitive issue or problem that is plaguing a large group of end-users. Team 

Helpdesk provides a means for the technician (in Outlook and web) or the customer (via web form) to create this hard-link between 

a troubled asset and a case. 

 

  



 

 

 Back to TOC 

P
ag

e4
6

 

7.5 Related Cases 
 

The ‘Related Cases’ tab lists all the ongoing and resolved cases logged for that particular caller, or department or company or email 

domain so the responsible technicians can have a panoramic view of all past problems history.  

 

 

Choose a filter (caller, department, company or domain name) that will be used to show related cases. 

 
Choose if to only display the related cases that are ongoing, resolved or both. 

 
Open the selected case in its own case form (e.g., inspector window). Alternatively, you can double-click 

the case entry to open it. 

 
Merge the selected cases to one single case. Sometimes, a caller might contact you through separate 

emails or channels regarding a particular issue. The same issue might be logged as a case by a different 

agent not knowing an existing one already exists. To avoid duplication and conflicts, you can merge all 

related cases together and keep the communication streamlined. 

The merge action is irreversible, and causes the following things to happen: 

a) One of the cases becomes the primary case (you get to choose).  

b) All conversations from the secondary tickets are moved into the primary case.  
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7.6 Associated Users 
 

Often a helpdesk may have the requirement to link certain stakeholders, apart from the caller, to a support case. Such users can be 

external vendors, contractors or secondary field technicians that are related to resolving the case, though might not be direct 

support technicians of the helpdesk.  

 

In Team Helpdesk, we have added a feature to associate any contacts from your Address Book (or Global Address List - GAL) to a 

particular case item, such that these associated users would receive a copy of the caller or technician specific automated 

notifications. Refer to Team Helpdesk Manager add-in > Settings > Notification Options > Associated Users Alerts. 

 

 

List of all associated users that are stakeholders to this case. 

 
Make a reply to the selected user. A new reply window in Outlook will pop up and the body of the email will be derived 

from the ‘Email to Caller’ template (customizable under Team Helpdesk Manager add-in > Templates Manager > General 

Alerts tab). 

 
Make a reply to all the users in the list. 

 
Manually add a new user to the list by entering the name and email address. 

 

 
Add a new user to the list by choosing it from the address book or global address list. 

 
Remove the selected users from the list (and de-associate from the case) 
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7.7 Logs 
 

The log grid lists all the important correspondence logs such as emails, SMS, calls made from the support case to the caller or 

technicians. Each log entry has a small description field, the date/time of the action as well as the technician who is working on it. 
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7.8 Notes 
 

The notes section enables the technicians to add private notes to the support case for internal use. 

 

 

Enter the new note that you would like to add to this case. 

 
Click to add the new note to the existing notes of this case. Each note that is added to the case bears a 

header title that has the technician name and the date and time the note was added. 

 
Existing notes of this case. Each note is separated by an empty line. 
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7.9 Related KB articles 
This section will show all the KB articles that are associated with the problem category/type information of the particular case. This 

provides the technician an easier way of finding a relevant KB article that has the solution/fix to the caller's issue. And when such a 

KB article is found, the technician can quickly email it to the caller (as inline content or as PDF or XPS attachments). 

 

 

Shows the list of KB articles available on the same problem category and type. For example, as the current case is tagged 

to ‘Notebooks’ category and ‘MacBook’ type, the number of KB articles that filed under this category and type are shown 

so that you and other technicians can confine your search for a possible clue or answer to the issue on a smaller subset of 

articles. 

 

 
Open the selected KB article in its own KB form inspector window (of Outlook). Alternatively, you can double-click that 

particular KB article to open in its own form/inspector window. 

 
Arrange the KB preview pane side by side with the KBs list pane (vertical positioning).  

 
Arrange the KB preview pane to locate at the bottom of the KBs list pane (horizontal positioning). 

 
Make a reply to the caller of this case with the content of the currently selected and previewed KB article. 

 
The preview of the selected KB article. 
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8. Common Tasks 
Technicians can also perform various other tasks in the support request form - print, reply to the caller with a knowledge base or a 

predefined answer, publish the case to files or to a knowledge base, mark support request as resolved etc. 

 

 
Explicitly update this case to SharePoint. If this case has an existing copy in SharePoint, the add-in will sync any changes 

made to the SharePoint copy of the case. If this case has no equivalent case in SharePoint, a new copy will be created. 

 
Open the SharePoint copy of this case in your default web browser. 

 
Directly reply to last email received from the caller. You can also forward the last email received on that case. When you 

click the 'Reply’ button in the case form, it will make a reply to the last email that was received from the caller or sent to 

the caller, without actually searching and clicking the previous email. This feature would greatly improve the helpdesk 

productivity and decrease the number of clicks (without this, you would have to find that particular email from the 

communication chain, and once found, you will need to double-click to open it and click reply). 

 
Selective disabling of auto alerts to callers or technicians - Sometimes, on specific cases or caller or assigned technicians, 

you may want Team Helpdesk not to send auto notifications on activities or events of the case. So instead of disabling a 

particular auto-alert at the global level, you can choose to disable auto-alerts on per case. Simply check the options 

'Disable Notifications to Caller' or 'Disable Notifications to Technicians' from the particular case form.  

You can also set Team Helpdesk to automatically check both these options on newly raised cases from Team Helpdesk 

Manager > Case Options > Other Options tab. 
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With these two buttons, you can choose the layout of the case form -  either in tabs view or in Single Page view (or also 

known as List View).  

In tabs view, you will find multiple sections or tab that shows information on the case selectively. One needs to navigate 

its way to the desired section to uncover the information beneath. This view is best used to reduce cluttered-ness and 

information overload. 

 

 
In the Single Page view, all the tabs/sections of the case form are merged to present a continuous flow of information in 

the same page.  

 

Each section or tab is separated by a gray horizontal bar header. Clicking the bar hides or shows the information beneath 

the section. In this view, all the sections may not fit within the available screen area, but with the aid of the vertical scroll 

bar, you can navigate down to see the rest of the sections. 

At any time, you can switch the case view to tabs or single page. And the add-in remembers your choice of View when 

you open another case the next time. 

 
Enable 'edit mode' for the problem description field. By default, the HTML description field is locked. 

 
Mark the current support request as complete. This closes the case and is moved to the 'Resolved cases' folder. 

Notification about closed case is sent to caller, if enabled. 

 
Save any changes made to the form. 

 
Save any changes made to the form and exit the inspector window. 
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Generate a new knowledge base out of the current support request case. The generated knowledge base will be stored 

under the 'KB' folder. 

 
Print the current case using a template. 

 
Other Options menu  

 

Insert KB to Conversation - Select a KB item and insert into the problem description field. A dialog pops up and 

allows you to browse through the available KBs by problem category and type. 

 

Insert FAQ to Conversation - Select a predefined answer and insert into the problem description field. A dialog pops up 

and allows you to browse through the available predefined answers by problem category and type. 

Cancel Case - At times, you may accidentally have raised a new case from an email, and you may want the opportunity to 

cancel that case. 

 
Added two buttons to place the case form in left or right side of the inspector window of the opened item. 
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9. Case Preview Form 
'Case Preview' form shows all the available helpdesk fields including custom fields. Additionally, you can now see all the emails 

related to that case directly in the preview form. And you can reply or forward or send a KB directly without opening the case form. 

 

There are four (4) panels in the preview form 

 

The Case Summary tab shows all the available helpdesk meta fields including custom fields and the values these hold 

when you select or highlight any Outlook case item in the Ongoing Cases or Resolved Cases folders. These fields are 

listed under 10 groups - Analysis, General Information, Callers Information, Problem Information, Service Level, Time 

Spent, Custom Fields, Asset Fields, Additional Information and Logs. 

  



 

 

 Back to TOC 

P
ag

e5
5

 

 

If the selected case is ongoing, you would be able to mark it complete. If the case is resolved, you would 

be able to reopen it. 

 
Choose technicians that will be assigned to this selected case. 

 

 
Choose a service level to enforce to this selected case. 

 

 
Enter a new time spent value to this selected case. 
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Choose or enter associated users that have a stake to this selected case. 

 

 
Choose one or more assets (that are related to the issues reported by the caller) and associate it to the 

selected case. 

 
 

 

In the Emails tab, you can see all the related emails of that case (including emails received from the caller and sent to 

the caller from the helpdesk).  You can reply or forward an email to the caller or send a KB quickly without opening 

the Outlook inspector window.  

 

 

Quickly reply to the last email - This will make a reply to the last email that was received from the caller or 

sent to the caller.  

 
Make a reply to the selected email. 
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Make a reply from the selected email to the caller as well as to all the recipients in the CC field (if any). 

 
Forward the selected email to another user. 

 
Delete the selected emails permanently. 

 
Reply the selected email with a chosen snippet of the frequently asked question (or predefined answer). 

 
Reply the selected email with the content of a chosen knowledge base article (KB) including any 

attachments and images. 

  

 

In the Notes tab, you can see the private notes that are added by you and other technicians.  

 

 

Enter the new note that you would like to add to the currently selected case. 

 
Click to add the new note to the existing notes of the selected case. Each note that is added to the case 

bears a header title that has the technician name and the date and time the note was added. 

 
Existing notes of the selected case. Each note is separated by an empty line. 

 

 

The ‘Related Cases’ tab lists all the ongoing and resolved cases logged for that particular caller, or department or 

company or email domain so the responsible technicians can have a panoramic view of all past problems history. 

 

 

Choose a filter that will be used to show related cases based on the caller, department, company or 

domain name. 

 
Choose if to only display the related cases that are ongoing, resolved or both. 
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10. Conversation threading 
Most support requests cannot be closed within a single e-mail and response. Feedback from the caller and suggestions from other 

stakeholders often occur over multiple request-response emails. Moreover, different members from the support teams may provide 

resolutions during the course of the request. In practical scenario, a support case might have various e-mail versions of the 

resolution steps, making it cumbersome to get a complete picture of responses and resolution.  

With the conversation threading feature, Team Helpdesk captures the complete course of the conversation chronologically, from all 

email communications received or sent (including those automated notifications sent to caller and technicians in due course). The 

end result is a consolidated view where all the responses to a support request are collated together. Redundant and repeated 

conversations are filtered out to present only the relevant communications.  

 

This eases the task of the helpdesk and minimizes repeating what has already been done, while keeping support team members to 

stay on the track. Another advantage is it allows the technician to quickly glimpse through the thread and get a complete overview 

on the responses in chronological order and resolution applied to the particular support request, something which is hard to extract 

from viewing multiple email responses. 
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11. Raise a new empty case 
Sometimes you might need to raise new case based on the issue reported by your caller through phone calls. In such situation, you 

can press the ‘New Case’ button located in the helpdesk toolbar to raise a new empty case and feed the information including the 

issue description into the form. 

 

Within the empty case form, the first step you typically would like to start is by entering a short summary in the subject to enable for 

quick identification and then describe the issue in detail in the body field. You can insert supporting files as attachments (similar to 

how you attach a file when composing an email in Outlook). 

 

 
Enter a brief summary of the issue reported by the caller on the phone in the subject field. 

 
Enter detail description of the issue on the body field. 

 
Feed the caller name, email address, phone number, company etc. into the caller information section of the case form. 

Once the required details are entered into the form, either press ‘ID’ button or the ‘Save’ button would generate and assign a new 

ID to the case. You can then provide this ID to your caller on the phone. Additionally, the add-in will also automatically send a 

confirmation email alert to the caller. 
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12. Raise a new case from an email manually 
Support cases can be generated from diverse source such as incoming emails, appointments, tasks, phone calls or web forms and are 

available instantly to all members of the helpdesk team via Outlook or web browser.  

12.1 Convert email, appointment or task item to a case 
 

In your Inbox or calendar or task folder, select that particular email, appointment or task item and press 'Convert to case' located in 

the helpdesk toolbar to raise a new support case.  

  

This new case will be created under the ‘Ongoing Cases’ folder. You can then add further details (such as the classification of 

problems the request falls into) to the case form. 
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12.2 Raising a new case after sending the initial lead/contact to the caller 
 

Sometimes, the helpdesk team may need to initiate or start a case without a request received directly from a user. For example, you 

send a user the serial number for a software they have purchased not because of a request they sent in. So, typically, in such 

scenario, you are initiating the communication by sending them an e-mail that says “Your key is xxxxxxx and here is a link to the 

software”. At the same time, you want a case to be opened based on that email sent to them. 

To accomplish this, a check option 'New Case' is provided in the compose window of the email. So, when you check this option, and 

press 'Send' button, the email will be sent successfully to the caller/contact. At the same time, Team Helpdesk will raise a new case 

based on that email, with populating the caller details and the description of the problem/email. 

 

A new case is raised based on that email sent to the caller/contact. 
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13. Add an email to a case 
If you want to add an email to an existing case, click ‘Add to existing case’ button available in the helpdesk toolbar in your Inbox. 

This is useful if the caller emails the helpdesk multiple times on different threads but on the same issue or case. You can manually 

add such related emails to an existing case in a click. 

 

'Add to Existing case' is available in two variants:  

 

Through Search - The selected emails will be added to the chosen case in the search panel. If you don't know the case ID 

to which you want to update the emails to, use this method to search for cases that meet certain criteria and from which 

you can choose one quickly. 

 

 
Through ID - If you already know the Case ID to add the selected emails, you can enter it to update quickly. 
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14. Add replies to associated case 

If the emails from the caller already has a case ID embedded in the subject, you can press ‘Add to Case #’ button and the add-in will 

accordingly update the case with no further input required from you.  

 

Instead of manually updating the case with replies to existing case from callers, you can automate this process so that the agent add-

in will selectively monitor incoming emails and only process those replies that have embedded case ID in the subject and 

subsequently updates the associated cases. You can enable this automation from Outlook > Team Helpdesk toolbar > Settings > 

Personal Settings > Email Tracking – Incoming tab. 

 

 
By default, the add-in only tracks and processes the emails associated with existing cases from your primary mailbox. However, if 

you receive emails from callers to other mailboxes in your Outlook, then you must specify those mailboxes too. Enabling this would 

force your Team Helpdesk Agent add-in to look for incoming/outgoing emails in those mailboxes too. 
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15. Remove link to case from an email 

This button will be visible when you select any email that has a case ID (with or without Prefix code) in the subject. Clicking it will 

remove the references of the case from that email. You can then raise a new case from that email. 
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16. Working with Cases in SharePoint 
More and more organizations are integrating their CRM and ERP systems with SharePoint - to allow employees to access to 

information and documents from anywhere. Team Helpdesk integrates Microsoft Outlook seamlessly with your SharePoint portal to 

store copies of support cases in a configured list, facilitating remote technicians and other stakeholders to view, track and work on 

support request in a web browser, thus realizing the benefits of the helpdesk company-wide. 

Support technicians can quickly and easily publish support cases to SharePoint without the requirement of any configuration 

changes, nor the need for installing web-parts or solutions to your SharePoint site. Team Helpdesk makes use of the Windows 

SharePoint Services to read and write data, thus supporting updating remote hosted SharePoint as well as on-premise SharePoint 

installations, all from Outlook.  

 

Raise a new case in SharePoint via web browser 

You can raise a case directly in your SharePoint through your favorite web browser and the step is pretty much similar to adding a 

new list item in your SharePoint list. Click the ‘New Item’ link located as highlighted below. 
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Support Case form in SharePoint 

When a new support case is logged in Outlook, Team Helpdesk add-in automatically generates the SharePoint copy, almost instantly, 

without the user even knowing it. If existing support cases are updated in Outlook, the changes are also automatically synced to the 

corresponding SharePoint copies of the support cases. Any attachments and inline images in the Outlook case items are also carried 

over into the SharePoint copies, retaining the same formatting and styles. 

 

The SharePoint support request form is derived and generated automatically from the corresponding Outlook request form. With 

fields mapping tool (Outlook > File > Team Helpdesk Manager > SharePoint Mapping – Support Case panel), manager can choose 

which Outlook fields are to be made available in the SharePoint copies of the support cases. If the particular mapped field takes a 

drop-down list in Outlook such as Problem Category, Problem Type, Status, Callers Name etc., the same drop-down list values would 

be available in the SharePoint list automatically.  

In this way, the same helpdesk metadata and logic are carried over from Outlook to SharePoint. Over time, as manager make 

changes to the drop-down lists in Outlook, Team Helpdesk would automatically update the values in the schema definition of the 

SharePoint list. 
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Retrieve Cases from SharePoint to Outlook 
If you and other technicians have added new cases manually in SharePoint through the web browser, such cases are not synced 

back to the Team Helpdesk Ongoing/Resolved Cases folders in Outlook i.e., copies of such cases are not available in Outlook. Use 

this button to retrieve support cases that were created directly in the SharePoint list (via web browser) to the Ongoing Cases folder 

in Outlook. 

 

To retrieve and sync support cases from SharePoint to Outlook, navigate to Team Helpdesk > Ongoing Cases or Resolved Cases 

folder and Click ‘Retrieve from SharePoint list’. A pop up dialog box comes up, in which, SharePoint Cases not present in Ongoing 

and Resolved Case folders are available for synching back to Outlook. Check the particular cases to be retrieved from SharePoint list 

and then click the ‘Confirm’ button. The chosen SharePoint cases would now be available in the Ongoing Cases folder in Outlook. 

 

NOTE: This feature can also be automated via the Team Helpdesk Manager add-in i.e., Outlook with Team Helpdesk manager add-in 

will automatically check for new cases availability in the SharePoint list and generate copies in Outlook on the fly. To enable it, go to 

Team Helpdesk Manager > Automation Options > Other Information tab, and check the option 'Automatically bring newly added 

cases in SharePoint to Team Helpdesk folders in Outlook'. 

 

Further, you can set the interval the add-in would check for the new cases in SharePoint. Additionally, you can also allow the add-in 

to send out the case allotment notification to caller, case assignment notification to technicians.  
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17. Using Predefined Answers (FAQs) to reply emails 
There might be times when technicians just need to answer briefly to a frequently asked question from callers. Instead of framing 

the answer over and over again, just imagine how easy it would be if you can compose a predefined answer lists with relevant 

answer categorized by problems. With such a setup, it is very easy to reply to a support request email by just selecting the 

appropriate predefined answer and embedding it to the email.  

 

The predefined answers list is most prominently used in the outlook case form.  

  

When launched, the predefined answers dialog box 

displays questions which are arranged and grouped in a 

hierarchical tree (e.g. problem categories and types) 

allowing the technician to select an answer and reply to 

the caller.  

And the chosen answer (FAQ) is then inserted to a new 

reply, ready for dispatch to the recipient (e.g., caller of 

the case). 
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The predefined answers can also be used to select an appropriate answer and reply directly to emails (outside of Team Helpdesk 

folders) say in your Inboxes. In fact, they are available in appointments, tasks as well. 
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18. Knowledge Base 
The inbuilt knowledge base in Team Helpdesk allows help desk team to document best practices and solutions to common problems 

so that they can be used when replying to time-consuming and repeated queries. Any support case is eligible to become flagged as a 

KB Article.  A technician recognizing a repetitive support issue, can easily flag a resolved case as a knowledge article. Thus, it acts as 

an effective knowledge sharing medium, boosting support productivity by leveraging collective knowledge and providing invaluable 

KB Articles to support techs in a snap! It also helps in improving the average "First Call Resolution" timing significantly, as technicians 

find resolution to problems quickly.  

 

Knowledge base items in the KB folder are arranged in hierarchical tree (by group KB items into 'Problem Category' and then to 

'Problem Type'). This arrangement makes it very easy to browse for a particular knowledge base at the time of need. 

 

18.1 Outlook Knowledge base form 
Understanding the Outlook knowledge base form 

It is very easy to use the knowledge base in Outlook. A Question and Answer format is used to intuitively display Knowledge Base 

Articles. Each Article may have any number of file attachments associated, rich-text elements, and hyperlinks to other web pages. All 

articles are tagged with a related problem category and problem type, so it is easy to find a particular resolution at time of needs. 
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The unique ID that is assigned to the KB article. 

 
Displays the date and time the knowledge base item was created.  

 
Displays the date and time the knowledge base item was last modified. 

 
Drop down list of all available problem categories defined in Team Helpdesk problems list. You can select a value from 

the list to mark the category to which the current knowledge base item belongs to. 

 
Drop down list of all available problem types (sub-categories) of the selected problem category. When you select from 

the problem category drop down, another tier of problem type lists will be loaded in the type drop-down control. These 

nested tiers of categories/types are complete customizable to your organization's business model and act as somewhat 

of a guiding decision tree when you search for a particular knowledge base item in the folder. 

 
Check this option to set the KB article as 'private'. Private KB articles can be set to not publish to the online KB module of 

Customer Web Service (CWS) site. Further, you can also set Team Helpdesk to hide the private KB articles from showing 

up in the 'Reply with a KB' dialog panel. You can control these options from 'Team Helpdesk Manager Add-in > 

Advanced Options > KB' tab. 

 

 
Click this button to edit/revise the description content of the knowledge base. By default, once a knowledge base article 

is created, subsequent accessing displays the KB in read-only mode. 

 
Click this button to forward the current knowledge base item (including attachments) to a contact. 

 
Click this button to save any changes made to the current knowledge base and close the inspector window. 

 
Click this to save any changes made to the KB article (without exiting the window). 

 
Place the KB form on the left side of the window. 

 
Place the KB form on the right side of the window. 

 
the subject (or a question or a summary) of the current knowledge base. 

 
The description field of knowledge base item. It may have any number of file attachments, HTML formatting, and 

hyperlinks to other web pages etc. You can use the default Outlook formatting tools (such as bold, font, fore color etc.) 

on this field. 
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18.2 Creating a new knowledge base 
 

An empty knowledge base can be created directly from the KB folder, in which case, it would have to be fed manually. A knowledge 

base can also be generated from an existing Outlook item such as email, task or appointment. Generated knowledge base item will 

then inherit the email body (and its format) as well as any number of attachments. Technicians or helpdesk managers would then 

tag with a problem category and one of the types available for that selected category. 

To create an empty KB article from scratch, click ‘New KB’ button located in the helpdesk toolbar of the KB folder. 

 

To create a KB article using the contents of an existing email, click ‘Create KB’ button located in the helpdesk toolbar in your Inbox. 

 

And then choose the category and type to which the new KB belongs to and save it. A new ID will be generated and assigned. It is 

then available for reference by other technicians as well as for replying to recurring issues reported by your callers. 
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18.3 How to use the knowledge base 
 

A knowledge base solution can be used for replying to emails, support case or for embedding into an appointment/task or for simply 

forwarding it to an Outlook contact. A dialog window allows the technicians to browse through the existing knowledge base items, 

even preview it before it can be chosen for embedding into the particular Outlook item (email, appointment, task, support case etc.) 

Steps to embed a knowledge base to a new email, appointment, task or a support case. 

Select a particular outlook item (email in the screenshot below) and click the 'Reply with a KB' button to display the KB selection 

dialog. 

 

A pop-up dialog box allows you to browse through the existing knowledge base articles, and select the relevant article to be 

embedded either as Word, PDF or XPS attachment or as inline content into the email reply. 

 

Browse through the listed KBs by problem type and category. Click a KB subject from the tree view to preview the content. Finally, 

when you have found the appropriate knowledge base item, select 'Insert'.  
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The listing of all non-private KB articles available for references. KB articles are presented in tree-view layout with 

problem categories as parent nodes and problem types as child nodes. And KB articles are then shown, grouped by 

category and type.  

 
The preview pane - Choose a KB article and click to preview its content in the preview pane located below or right 

(depending on the chosen layout). 

 
If you have hundreds and thousands of KB articles, finding the relevant and right articles could be tricky. For ease, you 

can search the KB articles with a keyword to find all matching KB articles that contain the keywords. KB articles that 

matches the search will have light red background color for easy reference.  

 

 
Place the preview pane of the chosen KB article to the right (side by side layout) 

 
Place the preview pane of the chosen KB article to the bottom (top to bottom layout) 

 
You can embed the selected KB article directly into the body of the email reply. Any inline images and formatting are 

preserved in its original state in the reply also. 

 

You can also choose to insert as attachment in the form of a word document (*.doc), Adobe PDF (*.pdf), Microsoft XPS 

(*.xps) or as single file MHTML (*.mht). 

 

Additionally, you can also customize the attachment name of the PDF or Word document such as naming the attached KB 

article file with the ID of the KB, or with the subject summary or a combination of both. 
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Check this option to directly send out the reply to the recipient without showing the compose window of the reply. 

 
Once a KB article is found that resolves the issue as reported by the caller, choose it from the tree structure and click 

‘Insert’ to continue. 
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19. Search Cases  
So, you have a repository of support request cases stored in your exchange folders. As the number of logged cases multiplies, 

finding the right information at the time of need is crucial for helpdesk team. For example, more so then often, technicians 

would require querying information based on particular cases, assets, callers etc. Team Helpdesk supports a comprehensive 

search capability with rich filter sets including full text search on case description body, or on predefined drop-down lists such 

as caller, technician, department etc. 

 

 

 

Time Period: Choose a time period from the followings under which the search will be confined: 

Any 

Today 

Yesterday 

Tomorrow 

This week 

Last Week 

Next Week 

This Month 

Last Month 

Next Month 

This Year 

Last Year 

Date Range... 

On 
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Report Type: Choose a report type from the predefined ones below:  

Any 

Cases Created 

Cases Resolved 

Cases Ongoing 

Cases Worked 

Cases Due 

Cases Response Date 

Cases unassigned 

Cases lapsed - Due Time 

Cases lapsed - Response Time 

Cases with SLA Breach - Due Date 

Cases with SLA Breach - Response Date 

Cases with no Due Date 

Cases with no Response Date 

Cases with no Service Level 

Cases with no Caller 

  

 
Search By: Further refine the search by filtering through keywords or using one of the following helpdesk fields - 

Technicians, Status, Problem, Service level, Caller, Department, Company, Priority, Origin, Assets or Author. 

 

 
Group By: You can choose to group the cases either with - Technicians, Status, Problem Category, Problem Type, Service 

level, Caller, Department, Company, Priority, Origin, Assets or Author.  

 
Fields: You are free to choose which particular 

helpdesk fields/columns show up in the search 

result and report. Just click the 'Fields' button, 

and choose the wanted columns to include. 

The tool will remember your choice in 

subsequent runs. You can re-arrange the 

columns by drag-and-drop to get the kind of 

view you want. And the display order of the 

columns will be retained in subsequent 

sessions. 

 

 
 

 
Scope: Choose if to confine the search to your assigned cases only or include all cases. 
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Reply: Compose and send a reply email to the caller of the selected case.  

 
Reply with a KB: Choose a KB article and embed it to a reply email to the caller. 

 
Edit: Open the selected case in its inspector window in Outlook for viewing or further editing. 

 
Mark Complete / Re-Open: If the selected case is ongoing, you can click this button to mark it complete. And if it a 

resolved case, you can click to re-open it, 

 
Delete: Permanently remove the selected cases from the Team Helpdesk folders 

 
Export to PDF: Click this to export the selected cases to PDF document files. You can also export to Word Documents, 

HTML, plain text etc. 

 

 
 

Multiple cases can be batch exported. Just select multiple cases from the list and choose one of the document type to 

export to, and the batch wizard will perform the rest. 

 

 
 

You can control what case data are included in the files by customizing the 'Print' template under Team Helpdesk 

Manager > Templates Manager. For example, place the variable 'SCO_CASEDESCRIPTION' in the Print template such that 

the exported file (e.g. pdf) contains all the consolidated conversations (body) from the case item including inline images. 

 

 Print: Click this to print the selected cases using the 'Print' template (as defined under Team Helpdesk Manager > 

Templates Manager). If you select a single case to print, it will show you the print dialog option, where you can 

customize the layout, paper size etc. However, if you choose multiple cases, it will print directly using the default 

settings without displaying any ‘Print’ options. 
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20. Helpdesk Summary Reports  
Helpdesk summary reports play a vital role in keeping informed managers about recent cases - that were created, worked, 

overdue or resolved. Team Helpdesk provides an inbuilt tool that generates reports on support cases based on a specified 

interval such as today, this week, this month, last month etc. Any fields can be selected for inclusion into the reports and can 

be saved as to file or printed for sharing and easy distribution. 

 

There are four report view modes - List, HTML, HTML Editable and Grid. Noticed that this report tool also uses the same sets 

of search filters discussed in the last section. 

 

 
 

Each case in the search result is color coded to reflect the current status of the case. You can easily recognize which cases 

require the attention or review, and plan actions accordingly. 
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Time Period: Choose a time period from the followings under which the search will be confined: 

Any, Today, Yesterday, Tomorrow, This week, Last Week, Next Week, This Month, Last Month, Next Month, This 

Year, Last Year, Date Range, On 

 

The option 'Date Range…' allows for user selection of start and end date. 

 
 

 

 
 

Report Type: Choose a report type from the predefined ones below: 

Any, Cases Created, Cases Resolved, Cases Ongoing, Cases Worked, Cases Due, Cases Response Date, Cases 

unassigned, Cases lapsed - Due Time, Cases lapsed - Response Time, Cases with SLA Breach - Due Date, Cases with 

SLA Breach - Response Date, Cases with no Due Date, Cases with no Response Date, Cases with no Service Level, 

Cases with no Caller 

 

 
Search By: Further refine the search by filtering through keywords or using one of the following helpdesk fields: 

Status, Problem, Service level, Caller, Department, Company, Priority, Origin, Assets or Author. 

 

 
Group By: You can choose to group the cases either with:  Technicians, Status, Problem Category, Problem Type, 

Service level, Caller, Department, Company, Priority, Origin, Assets or Author. 

 

 
Fields: For finer control over the output of 

report, you can choose which fields (including 

custom fields and calculated fields) are to be 

included in the report.  

You can sort the items by clicking at the column 

headers, as well as also re-arrange the columns 

in the list view according to certain sequence of 

your choice, and even set the width of the 

columns. These formatting from the List view 

panel will be inherited on other tabs - HTML, 

editable HTML and Grids. 

The tool will remember your choice in 

subsequent runs. You can re-arrange the 

columns by drag-and-drop to get the kind of 

view you want. And the display order of the 

columns will be retained in subsequent 

sessions. 

 

 
 

Some useful calculated fields that you can include in the report: 
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• Raise Duration - interval between when the support request (email or phone call) was received and when 

the case was raised. 

• Response Duration - interval between when the support request was received (email or phone call) and 

when the first response was made to the caller (by a technician) 

• Open Duration - interval between when the case was raised and the current time. 

• Resolution Duration - interval between when the case was raised and when it was closed/completed. 

• Breach Duration - interval between when the case was due and when it was actually closed/completed. 

 

 
Scope: Choose if to confine the search to your assigned cases only or include all cases. 

 

 
Print the current report - When you click ‘Print’, you would be presented with the print dialog (similar to one used 

by Internet Explorer browser). Within that dialog, you would be able to customize the print settings. Note that, as 

there are multiple report modes (namely, list, HTML, Grid), the printed report will be sourced from the current 

mode (tab) that you are in. 

 

 
Save the current report to file – Once you get the look and feel of your report, you can then export the report to 

one of the many popular document formats supported such as Microsoft Excel sheets, Word documents, Adobe 

PDF, Rich Text or web page etc. 

 

 

 
List report view mode – This acts like a template to the other three report modes. For finer control over the 

output of report, you can choose which fields (including custom fields) are to be included in the report. You can 

sort the cases by clicking at the column headers, as well as also re-arrange the columns in the list view according 

to certain sequence of your choice, and even set the width of the columns. These formatting from the List view 

panel will be inherited on other tabs - HTML, editable HTML and Grids.  

 

 
 

 
HTML report view mode – This report view presents the cases in web HTML format with color coding, group, and 

summary information retained. You can export this report to .htm format for your further use. 
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HTML Editable report view mode – This report view is exactly the same as the previous HTML mode, but with the 

flexibility to edit the HTML content in a WYSIWYG editor. For instance, you can customize the font, add image, 

change the color, layout or add any further information you require so that you can compile your own report. 

 

 
 

 
The Grid report view mode – This presents the cases in excel spreadsheet like format with rows and columns, 

preserving color codes, summarized information etc. You can also re-edit and tweak the report. You can also copy 
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data from this grid to Microsoft Excel or vice versa. And you can of course export the report as Excel spreadsheet 

file (in XLXS, XLS format). 
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21. Helpdesk OLAP Statistics and Reporting 
 

With the integrated Online Line Analytical Processing (OLAP) tool, helpdesk managers can analyze the support request data in 

multidimensional view and extract mission critical information and intelligence that will enable better decision- in your 

helpdesk and organization. The tool supports the ability to explore large complex data sets and allows displaying in grids, 

charts and graphs and support most common operations such as pivoting, drill down/slice and dice, filtering etc. With such 

arrays of information, the organization can reengineer their help desk processes, reinforce resources and forecast problem 

areas and exploit all these factors for competitive advantage. 

 

Why OLAP? Real strength of OLAP is its ability to examine and view data in ways not ordinarily possible. By allowing varying 

levels of granularity during data inspection and visualization a lot of information can be revealed that would otherwise be 

hard to attain. Given that most business models are constrained by more than three dimensions, it is hard to fully evaluate a 

business without the ability to inspect each dimension in detail while preserving context eliminating all guesswork. OLAP is 

perfectly suited for this purpose. Now it’s easier than ever to spot new trends and discover unknown problems in your data 

flow. The statistical tool will help you gain an insight into your data and make new discoveries. Comes with various inbuilt 

reports specific to Team Helpdesk Cases. 

 

Reporting made easier - The statistical tool's simplistic point-and-click interface will ensure managers easily achieve the high-

level views of information they require. Additionally, the OLAP client makes creating reports destined for different 

management levels a simple task - eliminating managers' dependence on IT personnel. By unifying data analysis needs on a 

single platform, it provides an unparalleled array of reporting tools for web portals, intranet applications, websites, and other 

data-rich applications. 

 

Printing capabilities - you can print your report to share it with others using the built-in Print Preview window. You can tune 

your page/printer settings before printing. Also, if you feel like sharing the report through the net or by email you can easy 

export it to a wide range of formats including PDF, XLS, CSV, JPG, etc. 

 

Copy to Clipboard - Select any data range in Chart/Grid and copy to clipboard. Then you’ll be able to paste it in an Office 

program for further analysis. You can also paste the chart like a picture to illustrate your investigations. This greatly simplifies 

the task of creating detailed, data-rich documents. 

 

Save Reports in file - At any stage managers/technicians can save the report and distribute it to another person for analysis by 

network or email, so when the recipient gets the file he can open it and see the same OLAP slice. 

 

Launching the statistics tool: 

 

Go to Outlook > Team Helpdesk toolbar 

> Settings menu, and click ‘Statistics’. 
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You can choose what type of OLAP statistics on helpdesk data you would like to see and report on. You can specify if the 

statistics would be confined to ongoing cases or resolved cases or on both. You can further have the choice to include 

archived old cases that were moved to another exchange folder or PST file. 

 

 
 

There are two parts of OLAP Statistics 

 

 

General OLAP 

Choose this OLAP to run statistics on cases with all helpdesk parameters and fields except for time spent by 

technicians on cases. 

 

 

Time Spent OLAP 

Choose this OLAP to run statistics on time spent entries by technicians on cases. 
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21.1 The User Interface 

 
The statistical tool presents an easy-to-use interface for operating an OLAP-slice. The basic data is displayed in the Working 

area. The environment tools for managing the content and characteristics of the slice are placed on the pivot panels. You can 

set the panels' layout the way you like. To drag a panel to a different location, you need to capture and drag its header with 

the mouse. At that, all the possible locations, where it can be dropped to, will be highlighted. You can detach a panel from the 

component; it will be displayed as a float window. 

 

 
 

Instrumental panels can be: 

• Attached to any side of the component;  

• Placed into any existing panel;  

• Displayed as bookmarks on any panel;  

• Set as auto-hidden panels;  

• Used as float windows. 

You can change the view of the slice by relocating measures and hierarchies within the environment panel. When you start 

dragging an element, all the possible locations, where it can be dropped to, will be highlighted. Most elements have context 

menus that duplicate the mouse actions and provide additional control functions for managing the slices' view. 

 

 

The File menu 

The file menu consists of the following commands: 
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a) Open Offline Cube from file - While generating a live cube from Outlook always provides the advantage of 

analyzing live data, often, you might be away or disconnected from the network. 
 
In such scenario, you have the option of connecting to an offline cube, which was previously generated and 
saved to your local folder using this utility. An offline cube file has the extension - .offlinecube and can be 
either in compressed or uncompressed format. An offline cube gives the same functionality as that of a live 
cube (which is generated from the Outlook data at real time), except that the data in the offline cube is only 
current to the time the cube was saved to file. This provides the flexibility to continue analyzing the cube 
and writing reports etc, while you are on the move. 
 

b) Open a Predefined View - Pre-defined reports are available under Assets, Cases, Callers, Date/Time, 
Problems, and Technicians nodes. Clicking one of child node report loads the statistical analysis of that 
report, the resultant of which will be displayed in the Grid or Chart (depending on the current active view). 
 

 
 

c) Load report file from Favorite – You can customize or create your own views and save them to the favorite. 
Once saved, your views would be saved under the ‘C:\Users\USERNAME\Documents\Team Helpdesk 
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Reports\Views’ folder (in windows Vista and 7). For windows XP, it should under My Documents. When you 
open the favorite from this menu, you can choose to load your saved view. 
 

 
 

d) Open report view from file - Once a particular snapshot of the statistics is achieved, you may want to save it 
for future reference or share it among your team members. A report view is the current state of the 
statistics in the Grid/Chart working area, with specific member fields on the pivot panels (Rows and Column 
areas) and measure fields in the values area. It has a file extension ‘.olapreport’. 
 

 
 

e) Save report view to favorite – You can save the current view of the statistics (grid or chart) to the favorite, 
by specifying a name of the view. 
 

 
 

f) Save report view as - If you want to share a report view with others, you can simply save the current report 
(state of the statistics along with the pivot details) to a file folder of your choice - could be a network folder 
also. 
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g) Save to offline Cube – Once you have loaded a live cube from the cases, you have the option to save the 
entire cube data to a file (with the extension - .offlinecube) for offline use, when you are disconnected from 
the network. Offline cube can be saved in compressed or uncompressed format, the former option will 
enable you to reduce the file size considerably. 
 

h) Same as e. (above) 
 

i) Close the cube - This option closes the cube from the OLAP Statistics and free up the memory for loading 
another cube. 
 

 

View Menu 

Contains actions that you can perform on the current report view. 

 
 

a) Reset Chart/Grid - Empty all the member fields from the pivot as well as the data from the working area of the 
chart/grid. This is useful if you want to start over on a new report view. 
 

b) Synchronize Chart/Grid - This option allows you to reflect the state of the statistics between the Grid and the 
chart. It is particularly useful, for example, when you have built up a grid with aggregated data, but want a more 
visual representation of the statistics in form of graphs and bars. Also note that, the synchronization will be 
done to the other part (grid or chart) based on the current interface.  
 
For example, if you are in the grid view, and if you pressed ‘Synchronize Chart/Grid’ it would read the state of the 
Grid view and impart the same state (same members and measures) to the Chart view and vice versa. Each of 
the Grid and Chart view can be worked independently as long as you don’t press this synchronize option. 
 

 

OLAP Grid panel 

The OLAP Grid control comprises of a multi-dimensional table with expandable nodes. These nodes group and 

display data according to the hierarchies used to define the measures and dimensions upon which the underlying 

data has been organized. A unique feature of control allows for building the OLAP-reports of the exceptional level 

of complexity. In tandem with the OLAP Chart, the OLAP Grid provides an ideal means of clearly conveying data 

to the user. 
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OLAP Chart panel 

While OLAP Grid allows working with numbers, the OLAP Chart allows representing the project data graphically. 

This gives managers and members a unique opportunity to analyze their project data visually, dealing with charts 

rather than numbers, which is much easier to perceive. 

 

 
 

 

Cube structure panel 

The panel contains the Cube structure - measures and hierarchies as a tree. The measures are grouped in the set, 

displayed in a branch. Rest of the tree nodes are the dimensions that contain hierarchies. 

 

 

 - Measure 

 - Dimension 

 - Attribute hierarchy 

 - Multilevel hierarchy 

 

To select a measure for display you need to drag-n-drop it to 

the Measures panel or the data area.  

 

To select a hierarchy for display – drag-n-drop it to the 

hierarchy area or the pivot panel (rows or columns area). 

 

• Measures are grouped in the Measures category. 

• Hierarchies are sorted into folders - dimensions. If there's 
only one dimension in a hierarchy, it will be displayed in the 
tree root. 

 

Both hierarchies and measures have their own menus. Right click will call the context menu that gives you an 

option to place the element where you like. You can also filter the selected element (see Filtering hierarchies and 

measures) or place it to the selected panel. 

 

 

Pivoting panels 

A pivot table lets user design the report online by dragging and dropping measures, dimensions and levels into 

the pivoting panels. Note that the column panel may contain no more than one (!) measure. Panel elements can 

be dragged with the mouse to other panels. To filter elements, press the Filter button (see Pivot panel view) or 

use the appropriate items from the context menu. 
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Measure panel 

Measure panel consists of groups of measures that make up the charts' vertical axes (see Measure panel 

components). Each group of measures corresponds to a set of charts in the data area. Groups of measures are 

situated in the main part of the panel. 

 

 
 

You can drag measures from one group to another, or extract measures from groups to delete them. To create a 

new group, you need to drag a measure to a place on the panel not occupied by another group or to the <drop an 

item to create a new group> panel. 

 

Clicking a mouse button on measures will call the context menu. From here, you can move a measure to one of 

the pivot panels or to the modifiers axis, or assign a measure filter. Also, you can assign the marker type of a 

chart point and its color. 

 

 

Filter panel 

This statistical tool allows for easy selection on what data you want to see and what you don’t. You can apply 

powerful filters to anything including hierarchy members, and measure values, thus leaving out the unimportant 

data. You can sort the data to see, for example, the top 10 values and then you can gather the rest of the values 

into a single group, so you only have what you really need. 
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The filtered elements (hierarchies and measures) 

are automatically transferred to the Filter panel. 

To assign a filter, you have to move an element 

to the Filter panel. If the element hasn't been 

filtered the appropriate visual filter editor will be 

shown, similar to the one on the right: 

 

 
 

 In the Filter panel, you can call the Filtered Element Editor individually for each element.  

 
 

 

Working Area 

The OLAP-slice data is displayed in working area. In its upper part there is a menu for the quick access to the 

frequently used commands². The rest is occupied by the current OLAP-slice and consists of the following parts - 

Cube Axis headers, Cube Axes, Data Axes, Data Axis headers, Chart Panes. 

 

You can change the view of the slice by relocating measures and hierarchies within the environment panel. When 

you start dragging an element, all the possible locations, where it can be dropped to, will be highlighted. Most 

elements have context menus that duplicate the mouse actions and provide additional control functions for 

managing the slices' view. 

 

Grid working area 

 
 

 

 

 

Chart working area 
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21.2 Working with the OLAP grid  
 

The OLAP Grid view is comprised of a multi-dimensional table with expandable nodes. These nodes group and display data 

according to the hierarchies used to define the measures and dimensions upon which the underlying data has been organized. 

In tandem with the OLAP Chart view, the OLAP Grid view provides an ideal means of clearly conveying data to the user. It is 

highly navigable and quickly provides detailed information to the user. The speed with which data recall occurs and the strong 

formatting the grid enforces ensure data is always presentable and easily understandable. Consequently, OLAP Grid views can 

easily be ported to spreadsheet applications for report compilation purposes.  

 

Additionally, the OLAP Grid view allows users to effortlessly add and remove categories, filter and sort categories, and drill up 

or drill down on data using powerful built-in menus. One of the greatest benefits this affords is that it allows users to explore, 

navigate and refine data until the desired snapshot is achieved. Once in place this snapshot can then be reflected in a 

complementary chart. This is possible as OLAP operations in Grid view can be synchronized with Chart view. These two data 

views can then be deployed side-by-side or on top of one another. 

 

 Unicode support.  
 Simultaneous display of several different measures in the Grid.  
 Simultaneous drilling down based on different parameters: up to the nearest child, up to the next level, up to the next 

hierarchy.  
 Saving and restoring the current OLAP-slice.  
 Hierarchy members grouping (including multilevel and parent-child hierarchies).  
 Separate sorting on different hierarchy levels. Possibility to override any sorting method.  
 Ascending or descending sorting based on the cell values in any column of the Grid.  
 Filtering of hierarchy members with or without applying these filters to the OLAP calculations.  
 Auto filtering of the hierarchy members depending on their values in the Grid. Major/minor members selection, either 

based on their rank or on the Pareto principle.  
 Replacing hierarchy members by drag-n-dropping them within the Grid.  
 Auto sizing of cells depending on their contents.  
 Flexible export to MS Excel, HTML, GIF, JPG, PNG, BMP, CSV, TXT, PDF formats. 

 

Operating the OLAP-slice 

The OLAP-slice data are displayed in a table, whose appearance may be amended to some extent. For operating the current 

OLAP-slice there are the following functions available: 

1. Navigation 
2. Selecting and copying data 
3. Drilling, sorting and moving hierarchy members 
4. Operating context menus 
5. Filtering data 
6. Editing data 
7. Setting the column width 

  

1. Navigation - You can easily navigate the data using the keyboard: 

Button  Action 

Home  Move to the first cell of the row 

End  Move to the last cell of the row 

PageUp  Move one page up 

PageDown  Move one page down 

Ctrl+Home  Move to the top left cell 

Ctlr+End  Move to the bottom right cell 

 

Using the mouse, you can scroll the table up and down. 

Mouse Action Component Action 

Scrolling the mouse wheel Vertical scrolling of the table 

Scrolling the mouse wheel with the Shift button held down Horizontal scrolling of the table 
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 2. Selecting and copying data - The data area in the component can be selected like everything else in Windows: 

• Select all the cells pressing Ctrl+A;  
• Capture the area with the mouse;  
• Change the boundaries of the selected area with direction buttons, holding down the Shift button.  

You can copy the data from the selected area to the clipboard by pressing Ctrl+C. If there’s no selection, pressing these buttons will 
copy the whole OLAP-slice to the clipboard. 
 

3. Drilling, sorting and moving hierarchy members - To 
perform the drilling of the hierarchy members press 
buttons on the Grid cells. If there’s only one drilling 
button in a cell, then, instead of pressing it, you can 
double-click the cell itself. By default, the drilling 
buttons are shown only in the cells under mouse. To see 
all the buttons, press the Ctrl button. The last cells in 
the column area of the hierarchy members allow 
showing the sorting direction. A pointer that indicates 
the descending order of data illustrates it. You can 
manage the sorting modes by single clicking on the cells 
of the specified area: they are changed cyclically 
[descending sorting] -> [ascending sorting] -> [no 
sorting]. 

 

 

4. Operating context menus -The context menu, 
called by right clicking a table cell, partly duplicates 
the OLAP-slice control functions. 
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Hierarchy levels' menu 

The view of context menu of the hierarchy levels' area. There is a list of commands available in the context menu of the hierarchy 
levels’ area: 

Command Function 

Show totals first Show the aggregated cells before all the rest 

Show totals last Show the aggregated cells after all the rest 

Don’t show totals Do not show the aggregated cells 

Default sorting Range hierarchy members by default 

Sort ascending Range the hierarchy members by values from the bottom to the 

top 

Sort descending Range the hierarchy members by values from the top to the 

bottom 

Aggregate all hierarchy 

members 

Aggregate all the hierarchy members (including hidden) 

Aggregate visible members only Aggregate the visible hierarchy members only 

Drill all down\ to the next 

hierarchy 

Drill all down to the next hierarchy 

Drill all down\ to the next level Drill all down to the next level 

Drill all down\ to the same-level 

children 

Drill all down to the same-level children 

Drill all up Collapse all the elements of this level 

Clear filter Remove any applied filters 

Filter on captions Set the filter for measures 

Show empty cells Show the cells with no aggregated values 

Create new group … Create a new group. It will appear at the first level of the 

hierarchy 

Copy selection Copy the selected area to clipboard 

Conditional formatting Show the Conditional formatting menu 

 

 

Hierarchy members' menu 

 
The view of the context menu of the hierarchy members' area 

 

 

 

Command Function 
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Drill down to the next 

hierarchy 

Open the node up to the next hierarchy in the current area, ignoring 

all the lower levels of the current hierarchy 

Hide this member Hide the member 

Hide all members except 

this 

Hide all the members of the hierarchy, except the selected one 

Hide all members above 

this 

Hide all the members of the hierarchy above the selected one 

Hide all members below 

this 

Hide all the members of the hierarchy below the selected one 

Show only the top Show the top elements of the level. Their number is specified in the 

sub-menu. If you specify a percent value there, then the picking of 

members will be such that their total value does not exceed the one, 

specified in the sub-menu. 

You can choose a threshold value from those offered in the 

appropriate menu item or set your own one, selecting Other from the 

menu. 

Show only the bottom Show the bottom elements of the level. Their number is specified in 

the sub-menu. If you specify a percent value there, then the picking of 

members will be such that their total value does not exceed the one, 

specified in the sub-menu. 

You can choose a threshold value from those offered in the 

appropriate menu item or set your own one, selecting Other from the 

menu. 

Filter on captions Set the filter for measures 

Create new group.. Create a new group on the current level 

Copy selection Copy the selected area to clipboard 

Conditional formatting Show the Conditional formatting menu 

 

The menu for groups of hierarchy members 

 
The context menu that appears above the group cell. 

 

 

 

 

 

Command Function 
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Hide this member Hide the selected member 

Hide all members except this Hide all the hierarchy members except the selected one 

Hide all members above this Hide all the hierarchy members above the selected one 

Hide all members below this Hide all the hierarchy members below the selected one 

Show only the top Show the top elements of the level. Their number is specified 

in the sub-menu. If you specify a percent value there, then the 

picking of members will be such that their total value does not 

exceed the one, specified in the sub-menu. 

You can choose a threshold value from those offered in the 

appropriate menu item or set your own one, selecting Other 

from the menu. 

Show only the bottom Show the bottom elements of the level. Their number is 

specified in the sub-menu. If you specify a percent value there, 

then the picking of members will be such that their total value 

does not exceed the one, specified in the sub-menu. 

You can choose a threshold value from those offered in the 

appropriate menu item or set your own one, selecting Other 

from the menu. 

Filter on captions Set the filter for measures 

Create new group Create a new group 

Delete this group Delete the selected group 

Clear this group Clear the selected group 

Rename this group Rename the selected group 

Copy selection Copy the selected area to clipboard 

Conditional formatting Show conditional formatting menu 

 

 

Measure values' menu 

 

 The context menu that appears above the group cell: 

Command Function 

Sort ascending  Range the cells in the column by values from the 

bottom to the top  

Sort descending  Range the cells in the column by values from the top 

to the bottom  

No sorting  Remove any sorting  

Filter on captions  Set the filter for measures 

Hide these measures Hide the selected measure 

Show as Specify the display mode of the current measure in 

the Grid: 

default 

percent aggregated value in the row 

percent parent element of the row 
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percent parent element of the column 

percent total aggregated value 

Copy selection Copy the selected area to clipboard 

Conditional formatting Show conditional formatting menu 

 

5. Filtering data - The filtered elements (hierarchies or measures) are automatically placed on the filters' panel. To start filtering, 
move the element to the filters' panel. In case the element has not been filtered, the appropriate editor will launch (the Hierarchy 
Editor for hierarchies and the Measure Filter Editor for measures). In the filters' panel, you can launch an editor for each element 
independently. 

The buttons for launching the editor ( ) are placed on the 
panels in the Hierarchy levels’ area. If the button looks like 
this ( ), it means the hierarchy had hidden members inside. 
Pressing the button starts the Hierarchy editor. 

 

 
 
6. Setting the columns' width - You can change the width of columns in the data display area by dragging the right boundary with 
the mouse. If possible, these changes will be saved during other operations with the table (like drilling, sorting, etc.) To return to the 
original width, double click the right boundary of the column where it is visible. In case there were such changes in the table that 
saving the assigned width of the columns was impossible (for example, if as a result of the Collapse drilling, the column with the 
assigned width has disappeared), it will be set automatically. Unfortunately, if you operate a big table, calculating the columns’ 
width takes up too much time. That is why if there are more than 10, 000 cells in your table, their width will be set to default, but it 
can be corrected later. 
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21.3 Working with OLAP Chart 
 

While the Grid view allows working with numbers, chart view allows representing your helpdesk data graphically. This gives 

you and other managers a unique opportunity to analyze helpdesk data visually, dealing with charts rather than numbers, 

which is much easier to perceive. Now it’s easier than ever to spot new trends and discover unknown problems in your data 

flow. The statistical tool will help you gain an insight into your data and make new discoveries. 

 

 
 

Tools panel 
This panel houses all the frequently used operations on the OLAP chart - save, export, print and display options. 

Button Function 

 Load the Grid state 

 Save the Grid state 

 Export OLAP-slice data 

 Print OLAP-slice data 

 Preview 

 Undo 

 Redo 

 Switch axes 

 Select the docking panels layout 

 Set the scale of Chart display 

 Select the color palette for measures 

 

 

Modifier panel 
Modificators are easy and powerful means of data representation. You can choose your data be shown in different colors, using 
different shapes and sizes, so that you can easy distinguish them in a single graph. You can simply place a dimension or a measure on 
a modificator’s pane and get the graph showing different values in a different manner. 
 
For example, you might place the "Problem Category" dimension on Color pane and get the Chart showing problem categories in 
different colors. Or you can place the "Cost" measure on Color pane to highlight the top rates of supporting the service requests. The 
same can be done for Shape and Size so that you can make your data perfectly distinguished. 
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The layout of panels and hierarchies on the Modifier panel allows you to change the appearance of the displayed slice. When an 
element is placed to the modifier panel (except for Details), its legend will contain the display parameters. If you modify the color 
and shape of an element, the appropriate parameters can be amended. 
 

Modifier The changes made upon placing a Chart element to the modifier area of... 

a measure a hierarchy 

 

  

The color of the Chart elements will be 

chosen from the standard set of gradient 

colors  

 

Hierarchy members will be painted with 

the colors from the current palette 

Color The elements with the minimal value will 

be painted with the first of the gradient 

colors, and the elements with the 

maximal value - with the last one 

 

N/A 

Size Depending on the value of the measure 

the size of the Chart points will vary 

from the minimal to the maximal. 

 

Hierarchy members will differ in size 

Shape Forbidden Hierarchy members will differ in shape. 

If the number of hierarchy members will 

exceed the number of available shapes, 

some of them will be used more than 

once 

Details Forbidden The panels will display series for all 

hierarchy members 

 
If a measure is placed on the Color pane, its values range is mapped to the given colors range so that it’s tremendously easy to spot 
the top/low values. If you select the discrete gradient type, you'll be able to set threshold values for filling the Chart elements. While 
the continuous gradient will let you evaluate the trend as a whole. To select the gradient type and tune its content, turn to the 
legend panel. 
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The Legend panel 
The panel contains descriptions of the modified elements. 
The value, shape and color of a legend element can be 
edited. 

Setting the Color legend 
To select a color, simply double-click the appropriate element 
and choose a color from the pop-up editor. 

 

 

Setting the Gradient legend 
To edit the gradient, double-click the element and tune the settings in the 
editor. In the Gradient Editor there are: 

• a set of pre-made gradients;  
• selecting gradient option (continuous or discrete);  
• creating a gradient with a set number of intermediate colors option;  
• setting threshold in per cent and measure values option;  

 

Selecting threshold color option. 

 

 

 

 

Setting the Shape legend 
The shape selection is made through the context menu. This 
option is available only for points or lines Charts. If the 
number of hierarchy members exceeds the number of 
available shapes, they will be repeated. 
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Chart Panes 
The bulk of the OLAP-slice data are placed into cells with Charts. Each measure group has its own set of panes.  
 

 
Measure groups with corresponding Charts in the working area 
  

Chart Type 

In the upper left part of each Chart, there will appear a 
context menu for selecting its type. There are six (6) charts 
that you can use, namely, Point Chart, Histogram, Point 
Shape Selection, Lines, Curved lines and Step lines. By default, 
the Histogram is used. 

 

The size of Charts can be changed to some extent. To expand 
a Chart along either one of the axes, you need to capture its 
boundary with the mouse and drag it. You can change the 
size along both axes (and return to default) through the tool 
menu in the upper part of the working area. 

 
Chart type menu 

 
  

Hot keys for changing the scale 

Ctrl+* Reset Scale to 1:1 

Ctrl+Num+ Zoom In 

Ctrl+Num- Zoom Out 

 
Navigation 
If the content of the Grid exceeds the client area, the scroll bars will appear. You can scroll down the data using the mouse wheel. To 
scroll the Grid in the vertical direction, turn the mouse wheel, while holding Shift. 

 
Selecting Data 

You can select Chart points with the standard Windows' method. Holding down the Ctrl button, you can add selected points, 

holding down the Shift button, you can select the horizontal range. You can filter the Grid's points while selecting. In that 

case, the corresponding hierarchy members will be filtered automatically. 
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Selecting and filtering parts of Charts 

a. Selecting some of the Chart points 

 

b. Selecting the Filter command 

 

 

c. The result 

 

Note: When moving the mouse cursor over a data axis, you are able to select a continuous range of members (if the axis is 
composed of them) or a range of values in Charts. 
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Filtering hierarchies 

In case you need to collect data not from the whole Grid, but just from a part of it, the component has a few functions at your 

disposal: they let you select or remove elements from the slice. Also, there is a standard option of exporting data into a 

number of formats and printing out the content of OLAP-slices. The simplest way of selecting data is through the context 

menu. When you click a hierarchy member on the Cube axis, there is a set of commands for quick operations with members: 

• Hide this member  
• Hide all members except this  
• Hide all members above this  
• Hide all members below this  

Filter on hierarchy level 
The Filter area of the Editor becomes visible only in case if filtering by hierarchy levels is available. To apply a filter to hierarchy 
members, you need to select a hierarchy level (if there's more than one) and assign the Filter condition in the Filter menu. In the 
same menu, there's a command to clear filter. 
 
Filtering hierarchy members 
If the search field is not empty, the "Find" command will make the component perform a search for hierarchy members, whose 
levels contain the specified string. You can narrow the search results by checking the "Exact matching" box.  
 

Filtering a single member of a hierarchy 
By default, the Editor is able to select any number of hierarchy members. To switch to the single-select mode, uncheck the 
"Multiselect" box. In that case, only one the hierarchy member with all its parents and members will be selected.  
 

 
  

Filtering measures 

There is a number of available parameters for filtering measures. In the same Editor, you can clear the filter. 
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21.4 Predefined Reports 
 

Predefined reports allow helpdesk managers and technicians to quickly and 

easily retrieve information for common inquiries. Reports play a vital role as 

far as a Help Desk product is concerned. Requests that are open, closed or 

overdue at any instant of time, which person or department is sending the 

most number of requests & who is attending to the requests can all be known 

from the readymade reports available with the statistical tool. Each pre-

defined report works in both OLAP grid and OLAP chart view.  

  

There are several predefined reports in each of the report categories, and 

each report is run directly on a mouse-click from the tree view. Around 40 

reports are made available for instant details about the help desk activities. 

Any of the predefined reports can be also be edited so you can customize the 

report to return specific results: 

 

• Reports by Assets 

• Reports by Cases 

• Reports by Callers 

• Reports by Date/Time 

• Reports by Problems 

• Reports by technicians 

 

All these categories have reports available based on Department, Priority, 

Requester, Technician, Category and Request Date. 
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Some sample OLAP charts of the predefined reports 

 
A) Time spent on Asset 

 

 

B) Cases Count by Origin 

 

 
C) Average time spent on caller 

 

 

D) Due date  

 

 
  

E) Cost per problem category 

 

F) Time spent by technician 
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21.4 Printing, exporting statistical data and charts  

 
Now that you have successfully designed a report, you might want to save it for future reference or share it with others. 

Reuse your work! You can now save data snapshots to HTML, BMP, CSV, GIF, HTML, JPEG, PDF, PNG, TIFF, TXT, XLS and XML 

as a simple way of reusing your data for documents and spreadsheets. Depending on the active view (Grid or Chat), the saved 

file would either take the grid data or the chart. 

 

 

 

 

Available export formats in Chart View  Available export formats in Grid View 

Printing 
You can print your report to share it with others using the built-in Print Preview window. You can tune your page/printer settings 
before printing. Also, if you feel like sharing the report through the net or by email you can easy export it to a wide range of formats 
including PDF, XLS, CSV, JPG, etc. 

 

 

Export Settings -This tool allows you to customize the appearance of the reports to be printed or saved to a file format. You can 
specify the page size, orientation, headers & footers and color of the fonts and page background. 
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22. Contact Manager  
The Contact Manager is a consolidated view of all available contacts in the caller and technician lists, listing the email address, 

mobile and phone numbers. A quick correspondence can be initiated to a particular contact in a single click via email, SMS or 

phone call. 

 

  

 

Compose an email with the contact email address already populated in a new email inspector window. 

 

 

 
Allows you to choose a knowledge base article and then insert it on a new email with the contact email address 
already populated. 
 

 

 

 

Allows you to choose a FAQ answer and then insert it on a new email with the contact email address 

already populated. 

 

 

 

Compose a SMS message to send it to the mobile number of the contact. 

 

 

 

Make a call (either Skype or attached phone) directly to the mobile number of the contact. 

  

 

 

Make a call (either Skype of attached phone) directly to the telephone number of the contact. 
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23. Uninstalling Team Helpdesk Agent add-in  
 

To uninstall the Team Helpdesk Agent add-in from your computer, follow the steps outlined below: 

 

Step 1: Go to ‘Control Panel > Programs and Features’.  Scroll down to select ‘Team Helpdesk Agent (x86) or (x64)’ and click 

‘Uninstall’ as illustrated below: 

 

 
 

Step 2: A dialog confirmation follows asking for confirmation. Click Yes.  

 

 
 

Step 3: The Team Helpdesk setup will now start the un-installation process. Make sure that Microsoft Outlook is not running (even 
under the task manager). 
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24. Important links  

 

Team Helpdesk for Outlook and SharePoint - Home page 

Go to the official website of Team Helpdesk for Outlook and SharePoint.  

  

Video Tutorial clips  

Watch video tutorials that teach you how to install, configure and work with Team Helpdesk.   

   

Purchase license  

Purchase an enterprise team license for Team Helpdesk for Outlook and SharePoint.   

   

Knowledgebase Articles  

Looking for an in-depth understanding of this application? Browse through a series of knowledge base articles 

on Team Helpdesk online.  

   

Support Maintenance contract  

At AssistMyTeam, we're committed to give you the best support for all the products that we offer and more! 

The AssistMyteam Support Contract helps you use our products more efficiently and work out any issues that 

you encounter during the course of their use.   

   

Submit an online support ticket  

Use this web form to create a ticket with AssistMyTeam Technical Support.   

   

 

 

https://www.assistmyteam.com/helpdesk-addins/
https://www.assistmyteam.com/helpdesk-addins/
https://www.assistmyteam.com/helpdesk-addins/
https://www.assistmyteam.com/helpdesk-addins/video-tutorials/
http://www.assistmyteam.net/TeamTimeSheet/TutorialClips.asp
https://www.assistmyteam.com/helpdesk-addins/purchase/perpetual-license/
http://www.assistmyteam.net/TeamTimeSheet/Purchase.asp
https://www.assistmyteam.com/helpdesk-addins/purchase/perpetual-license/
http://www.assistmyteam.net/TeamTimeSheet/Purchase.asp
https://www.assistmyteam.com/helpdesk-addins/kb/
http://assistmyteam.net/KB/index.php?option=com_content&view=category&id=3
https://www.assistmyteam.com/support/
http://www.assistmyteam.net/support/
https://www.assistmyteam.com/support/submit-ticket/
http://www.assistmyteam.net/support/submitTicket.asp
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